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1 Main Index

  Montezuma Help Index

  Getting Started

  Montezuma Remote

An Introduction To CQuat Fractals by Terry W. Gintz

Tutorial On Juliat Fractals by Terry W. Gintz

  Commands
File menu
Edit menu
Image menu
Type menu
Render menu
Pixel menu
View menu
Window menu
Video menu
Demo menu
Help menu

1.1 Title Bar

Title Bar

The title bar is located along the top of a window.  It contains the name of the application and
drawing.

To move the window, drag the title bar.  Note: You can also move dialog boxes by dragging their
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title bars.

A title bar may contain the following elements:
Application Control-menu button
Drawing Control-menu button
Maximize button
Minimize button
Name of the application
Name of the drawing
Restore button

1.2 Scroll Bars

 Scroll bars

Displayed at the right and bottom edges of the drawing window.  The scroll boxes inside the scroll
bars indicate your vertical and horizontal location in the drawing.  You can use the mouse to scroll to
other parts of the drawing.

1.3 Size (system) command

Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow
keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to

the border you want to move.  
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:  This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.

1.4 Minimize (system) command

Minimize command (application Control menu)

Use this command to reduce the Montezuma window to an icon.

Shortcut
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Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9

1.5 Maximize (system) command

Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a drawing window.

1.6 Move (system) command

Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog
box with the arrow keys.

Note:  This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7

1.7 Restore (system) command

Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the
Maximize or Minimize command.

1.8 Close (system) command

Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.
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Shortcuts
Keys: CTRL+F4 closes a drawing window

ALT+F4 closes the application

1.9 Previous Window (system) command

Previous Window command (drawing Control menu)

Use this command to switch to the previous open drawing window.  Montezuma determines which
window is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6

1.10 Next Window (system) command

Next Window command (drawing Control menu)

Use this command to switch to the next open drawing window.  Montezuma determines which
window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6

1.11 Switch to (system) command

Switch to command (application Control menu)

Use this command to display a list of all open applications.  Use this "Task List" to switch to or close
an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
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Cascade
Arranges open applications so they overlap and you can see each title bar.  This option does not
affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.  This option does not affect
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.

1.12 An Introduction To CQuat Fractals

  An Introduction To CQuat Fractals By Terry W. Gintz

In the process of exploring all possible extensions to a fractal generator of this type, I considered
using discrete modifications of the standard 3-D algebra to discover new and exciting images.  The
author of Fractal Ecstasy [6] produced variations of the Mandelbrot set by altering the discrete
complex algebra of z²+c.  The extension of this to quad algebra was intriguing.  There was also the
possibility of different forms of quad algebra besides quaternion or hypercomplex types.

Having modeled 3D fractals with complexified octonion algebra, as described in Charles Muses'
non-distributive algebra [7], it was natural to speculate on what shapes a "complexified" quaternion
algebra would produce.  Would it be something that was between the images produced with
hypercomplex and quaternion algebra?  quaternion shapes tend to be composed of mainly rounded
lines, and hypercomplex shapes are mainly square (see Figures 1 and 2.)  

Figure 1.  quaternion Julia set of -1+0i

Figure 2.  Hypercomplex Julia set of -1+0i
For those not familiar with the basics of hypercomplex and quaternion algebra, here are the algebraic
rules that define how complex components interact with each other:

i j k
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i -1 k -j

j k -1 -i

k -j -i 1
Table 1 Hypercomplex variable multiplication rules

i j k

i -1 k -j

j -k -1 i

k j -i -1
Table 2 quaternion variable multiplication rules

In both quaternion and hypercomplex algebra, i²=-1.  The hypercomplex rules provide for one real
variable, two complex variables, (i and j) and one variable that Charles Muses refers to as
countercomplex (k), since k*k = 1.  It would appear from this that k = 1, but the rules in Table 1
show that k has complex characteristics.  In quaternion algebra there is one real variable and three
complex variables.  In hypercomplex algebra, unlike quaternion algebra, the commutative law holds;
that is, reversing the order of multiplication doesn't change the product.  The basics of quaternion
and hypercomplex algebra are covered in Appendix B of Fractal Creations [8].  One other
concept important to non-distributive algebra is the idea of a "ring".  There is one ring in quaternion
and hypercomplex algebra (i,j,k). (There are seven rings in octonion algebra.)  If you start anywhere
in this ring and proceed to multiply three variables in a loop, backwards or forwards, you get the
same number, 1 for hypercomplex, and 1 or -1 for quaternion, depending on the direction you
follow on the ring.  The latter emphasizes the non-commutative nature of quaternions.  E.g. : using
quaternion rules, i*j*k = k*k = -1, but k*j*i = -i*i = 1.

For "complexified" quaternion algebra, the following rules were conceived:

i j k

i -1 -k -j

j -k 1 i

k -j i 1
Table 3 CQuat variable multiplication rules

Note that there are two countercomplex variables here, (j and k).  The commutative law holds like
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in hypercomplex algebra, and the "ring" equals -1 in either direction.  Multiplying two identical quad
numbers together, (x+yi+zj+wk)(x+yi+zj+wk) according to the rules of the complexified
multiplication table, combining terms and adding the complex constant, the following iterative formula
was derived for the "complexified" quaternion set, q²+c:

x -> x*x - y*y + z*z + w*w + cx
y  -> 2.0*x*y + 2.0*w*z + cy
z -> 2.0*x*z - 2.0*w*y + cz
w -> 2.0*x*w - 2.0*y*z + cw

Just to get a feel for this new formula, a fairly basic constant, -1+0i, was used for the initial 3D test. 
The extraordinary picture "Equilibrium"(Figure 3) was the result.

Figure 3.  Equilibrium -- cquat Julia rendering of -1+0i
Being familiar with the quaternion and hypercomplex renditions of the Julia set -1+0i, it appeared
that this image was a leap into hyperspace; the fractal seemed to literally expand in all directions at
once.  The next test used a Siegel disk constant, -.39054-.58679i, which Roger Bagula [9] had
recently sent.  The Siegel image (Figure 4) strongly suggested that cquats were indeed a new form of
space-filling fractal.

Figure 4  Siegel -- cquat Julia rendering of -.39054-.58679i 

Since then, Godwin Vickers has ported the cquat formula to the Persistence of Vision Ray-tracer
[10], and verified that the equilibrium image wasn't just an artifact of QuaSZ.  Nearly identical
images have been obtained in POV, using Pascal Massimino's [11] custom formula algorithm for 3D
Mandelbrot and Julia sets.

There remains the extension of cquat algebra to transcendental and exponential functions.  Any ideas
for this are welcome.  The built-in formulas in QuaSZ have been revised to include cquat variations
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where possible.
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1.13 Tutorial On Juliat Fractals

It is easy to speculate on what a true 3D representation of a 2D Julia set based on the complex constant
-1+0i would look like, but thus far no quad math has produced the figure you might expect.

Tutorial On Juliat Fractals

The 2-D version of this set is:

So given all the knobbies in this fractal, you would expect to see the same in a 3-D version.

Alas, using quaternion math for the formula z=z-1, you get:
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which blurs all the knobbies like a lathe-like turning.

Using hypercomplex math (hypernion type fractal), you get:

which again blurs all the knobbies, this time in a squred-off way.

My experiment with complexified quaternion math (cquat) produces:

which interestingly enough retains some of the knobs and adds a lot of links that aren't in the original 2-
D fractal.
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Fortunately, there are other quad maths that can be explored for their fractal producing characteristics.

Using the random quad generator in Hydra, I discovered a quad matrix that seems to be the closest
approximation to what is needed to generate true 3-D Julia sets.  

Since the matrix was found visually instead of logically, the image is shown first:

The squaring matrix for this fractal looks like:

i j k

i -1 k j

j k -1 i

k j i -1

and the derived iterative formula (for ẑ 2+c) is:

x -> x*x - y*y - z*z - w*w + cx
y  -> 2.0*x*y + 2.0*w*z + cy
z -> 2.0*x*z + 2.0*w*y + cz
w -> 2.0*x*w + 2.0*y*z + cw

Considering that in the 2-D world the iterative formula for ẑ 2+c is:
x -> x*x - y*y + cx
y  -> 2.0*x*y + cy

it seems that this quad math (which I have named Juliat) hits the target right on the button!

How strange that no algebraic rules have been established for this matrix, nor is it discussed as a
possible math for rendering 3-D fractals.

Note: these figures were all drawn using forty iterations, which gives a rather coarse 3-D surface, but
is necessary to fully reveal the shape of the Juliat fractal.    With 2-D fractals, the formulas are
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typically iterated 150 times or more.  At fewer than 20 iterations, Juliat fractals appear to have dabs
of paint spread across the figure. 

2 Montezuma Remote

  Montezuma Remote

The remote provides access to many of the most-used commands in Montezuma.  Info about each
button can be obtained by using the '?' located near the close box in the top right-hand corner of the
remote.

2.1 New button

   New button

Use this button to open a new drawing window in Montezuma.  This is useful to view minor changes
to a drawing.  Use the Copy Data and Paste Data commands from the Edit menu to transfer current
drawing parameters to the new window.

2.2 Undo button

   Undo button

Use this command to undo the last action.  An image can be continued after an undo, if continue was
enabled before the last action, but not after an image is resized.  Color cycling is disabled after using
Undo.

2.3 Size button

    Size button

This allows you to set the drawing area for a picture, independent of the Windows screen size.  It
also shows which size is currently in use.  The aspect for the drawing is based on the ratio of X
(horizontal width) to Y (vertical height.)  The size of an image can range in standard 4/3 and 1/1
aspects from 160X120 to 3564X2784 or you can choose a custom XY size.  The custom setting
allows for any size/aspect that system memory will permit.  The minimum size for an image is 40X30.
 Note: if the image is less than 100 width, the aspect must be 4/3 for solid guessing to work
properly.

2.4 Draw button

   Draw button

Use this button to draw or redraw the image for the current fractal variables.  Clicking inside the
draw window with the left-mouse button stops all plotting.  Use the Continue button on the toolbar
to restart plotting from the current column.  Note: the draw window that a plot is initialized in (by
clicking  on an Okay or Apply button or Draw) must have the focus to begin drawing.  With a lot of



Montezuma Application Help12

© 2011 -- Mystic Fractal

parameter or formula windows open for different draw windows, it is easy to mistake one window
for another.  So if the plot doesn't start immediately in the window that has the focus, check to see
that that window is actually the one you wanted to start a new plot in.  If it isn't, click on the title bar
for the window that the plot is activated in. The plot should then commence. 

2.5 Batch button

    Batch button

Here you set parameters for batching and saving random-generated images to disk.

2.6 Text button

This allows you to edit text and font and apply it to a drawing.  Select the font button to set the font
style, size and color.  In the text window click on Okay to add a line of text to the current image. 
(You can add multiple lines of text too, up to 80 characters.)  The cursor will change to a crosshair. 
Position the cursor where you want the text to start and left-click the mouse.  Note: font and title text
are saved in the file "prefs.txt" in Montezuma's startup directory.  Title text can also be edited (as a
single line only) in the Edit/Formula window.

2.7 Pilot button

Opens the Pilot window to adjust key parameters, rotate, zoom and redraw the figure interactively. 
The current image is reduced to one quarter normal for faster redraw.  Each click on a Pilot button
increments or decrements a parameter.  The Speed slider controls the rate at which the buttons
operate (default is 10.)

Press the space bar or Click on Ok to open a new window and draw the altered image full-size. 
Press Esc or click on Cancel to exit this mode without opening a new window.  

2.8 Abort button

   Abort button

Use this command to stop drawing.  Clicking inside a window's drawing area or close box (or the
program close box) will also stop the drawing.  Note: once a plot has started Montezuma continues
to draw the image for that window regardless of which drawing window has the input focus, until
done or aborted.  You can open and close other drawing windows without affecting the current
drawing, but only one drawing is active at any time. 

2.9 View button

    View button

Displays the entire plot, expanding or shrinking the image to fit in a maximized window without title
bar, scroll bars or menu bar.  At all other times, part of the picture is hidden by the inclusion of the

title bar, toolbar, scroll bars and menu bar.  To exit full-screen mode, press any key or click the left-
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mouse button.

2.10 Scan button

    Scan button

This generates a 3-D Julia set from a formula's Mandelbrot space.  Random points in a formula's
current Mandelbrot space are scanned for an interesting Julia set.  Rendering options are maintained
in the current fractal.  Equivalent to the 'F' hot key.  

2.11 Rend button

    Rend button

The current coloring filter and lighting variables are applied.  This allows you to see what the surface
texture looks like before the fractal is finished drawing.  Note: to randomize the coloring filter, click
on the Rand Rend button or select Random Render from the Demo menu.

2.12 Help button

    Help button

Use this button to open the help index for Montezuma.  

2.13 Palette button

    Palette button

Use the palette editor to modify the color palette in use.  

2.14 Light button

    Light button

Edit lightpoint and viewpoint variables 

2.15 Formula button

    Formula button

Use this button to change formulas or fractal type. 

2.16 Params button

    Params button
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Use this button to edit 3-D Parameters. 

2.17 Julia Set button

  Julia Set button

A random Julia Set fractal is generated using the current fractal type.  

2.18 Random Render button

    Random Render button

The current plot is ray-traced using random rendering values (randomizes coloring filter or
generalized coloring parameters.)  If the plot has been drawn in the current session (without using
undo or reloading) then the ray tracing will take place in real time, else the plot will be redrawn and
then ray-traced.

2.19 Save button

   Save button

Use this button to save and name the active drawing.  Montezuma displays the Save As dialog box
so you can name your drawing.  To save a drawing with its existing name and directory, use the File/
Save command.

2.20 Load button

   Load button

Use this button to open an existing data/image file in a new window.  You can open multiple image
files at once.  Use the Window menu to switch among the multiple open images.

2.21 Bmp button

   BMP button

Use this button to select the BMP format when loading and saving fractals.  This is the default
Windows bitmap format, readable by most Windows programs that use image files.  This is also the
fastest method of loading and saving fractals, but requires more disk space, since no compression is
used. Windows keeps track of the last six BMP files saved or loaded (displayed in the Files menu.) 

2.22 Png radio button

   PNG radio button

Use this button to select the PNG format when loading and saving fractals.  This format uses medium
compression without loss of image quality.
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2.23 Jpg radio button

   JPG radio button

Use this button to select the JPEG format when loading and saving fractals.  This format uses
moderate compression but with some loss of image quality.  This is preferable for posting to the net,
since most browsers can display jpeg files.

2.24 ||||| button

   ||||| button

Through a series of windows, this allows you to name and open an avi animation stream and choose
a compression method.  After using the file requester to name the file, you are given a choice of
compression methods.  The compression methods include Intel Indeo Video®, Microsoft Video 1
and Cinepak Codec by Radius.  (All compression methods degrade the original images, some more
than others.)  The frames in the frame buffer are then written to the avi stream and the stream closed.

2.25 > button

   > button

Montezuma uses a frame buffer to compose an animation.  You add key frames to the buffer with this
command.  Each key frame is identical to the active image.  Change  variables between key frames to
create the illusion of motion or morphing.  You can edit the frames with the frame editor.

2.26 [] button

    [] button

Opens the frame editor window so you can edit frames in the video buffer by using any of the other editor
windows.  The Move button allows you to move a frame from one spot in the buffer to another.  You can
change the frame image being edited by using the Frame slider or Edit box.  After changing frames, use
the Preview button to display the current frame being edited.  The Delete button allows you to delete all
but two of the frames, the minimum number of frames to create a movie.  (If you want to delete all the

frames, use the Video/Reset Frames command.) . 

2.27 V button

    V button

Opens an avi file for viewing.  You can preview any multimedia file by clicking on its file name.  A
multimedia box will appear to the right of the file list.  Click on okay to open the main view window.

There are buttons to Play a file forwards or Backwards, or forward automatically with Auto rewind/
repeat.  Click on Slow to slow down a video.  Each click on Slow halves the viewing speed.  A
click on Stop freezes viewing and restores the view speed to normal playback.
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Use the Open button to view a different avi file.  Use the Save button to save the file in a different
compression format.  You must use a different name to save the file than the name that was used to
open it.  Click on the left-mouse button or any key to abort a save operation.

Note: the view avi requester can be used to preview any multimedia file, including midi files. 

3 File Menu

 File menu commands

The File menu offers the following commands:

New Creates a new drawing.
Open     Opens an existing drawing.
Close     Closes an opened drawing.
Save Saves an opened drawing using the same file name.
Save As     Saves an opened drawing to a specified file name.
Load Parameters     Load parameters from an existing drawing.
Load Palette [PQZ]    Load palette file.
Load Texture     Load QuaSZ texture file [QTX]
Open [JPG]     Load jpeg.
Open [PNG]     Load png.
Save Parameters     Save parameters for an opened drawing to a specified file name.
Save Palette [PQZ]    Save palette to file.
Save Texture     Save texture file [QTX].
Save As [JPG]     Save in jpeg format.
Save As [PNG]     Save in png format.

Import Options 
Palette [MAP]     Load a Fractint map file.

Export Options 
Save as [OBJ]     Save polygonized 3-D fractal as Wavefront object.
Simplify     Simplify mesh.
Save Zbuffer [OBJ] Save zbuffer as Wavefront object file
Set Zbuffer Threshhold Set threshhold to map zbuffer faces
Save as [POV]    Save polygonized 3-D fractal as a pov triangle object.
Smooth     Convert triangle mesh to smooth_triangle mesh.
Set Max Faces    Set target face size for mesh-simplification option.
Save As [STL] Save polygonized 3-D fractal as STL solid file.
Save as [WRL]    Save polygonized 3-D fractal as virtual reality file.
Save as [DXF]    Save polygonized 3-D fractal as AutoCad dxf file.
Save as [PLY]    Save polygonized 3-D fractal as Ply file.
Set Max Indices    Set maximum number of vertices allocated for Q polygon.
Exit Exits Montezuma.
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3.1 New command

   New command (File menu)

Use this command to create a new drawing window in Montezuma.  The image and data for the
opening picture are used to create the new window.

You can open an existing data/image file with the Open command.

Shortcuts
Keys: CTRL+N

3.2 Open command

   Open command (File menu)

Use this command to open an existing data/image file in a new window.  You can open multiple
image files at once.  Use the Window menu to switch among the multiple open images.  See 
Window 1, 2, ... command.

You can create new images with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O

3.2.1 File Open dialog box

File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.  This box lists files with the extension you select in
the List Files of Type box. 

List Files of Type
Select the type of file you want to open.

Drives
Select the drive in which Montezuma stores the file that you want to open. 

Directories
Select the directory in which Montezuma stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 
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3.3 Close command

   Close command (File menu)

Use this command to close the window containing the active image.  If you close a window without
saving, you lose all changes made since the last time you saved it.

You can also close a drawing by using the Close icon on the drawing window, as shown below:

3.4 Save command

   Save command (File menu)

Use this command to save the active drawing to its current name and directory.  When you save a
drawing for the first time, Montezuma displays the Save As dialog box so you can name your
drawing.  If you want to change the name and directory of an existing drawing before you save it,
choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S

3.5 Save As command

   Save As command (File menu)

Use this command to save and name the active drawing.  Montezuma displays the Save As dialog
box so you can name your drawing.  

To save a drawing with its existing name and directory, use the Save command.

3.5.1 Save As dialog box

File Save As dialog box

The following options allow you to specify the name and location of the file you're about to save:
File Name

Type a new filename to save a drawing with a different name.  Montezuma adds the extension .
mn6 to the data file.

Drives
Select the drive in which you want to store the drawing.

Directories
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Select the directory in which you want to store the drawing.
Network...

Choose this button to connect to a network location, assigning it a new drive letter. 

3.6 Load Other

3.6.1 Parameters command

   Load Parameters command (File menu)

Use this command to load a data file [.mn6].  The data file contains all variables to recreate an image
created previously with Montezuma.

3.6.2 Palette command

   Load Palette command (File menu)

Use this command to load a palette file [.pqz].  The palette file contains a palette created previously
with Montezuma.  You also have the option in the file descriptor box to select palette and coloring
filter, to reload both palette and the coloring filter that was saved along with it.

3.6.3 Texture command

   Load Texture command (File menu)

Use this command to load variables that make up the texture and noise parameters.  This also loads
the palette, coloring filter, orbit trap and coloring options in a texture file [qtx].

3.6.4 Open [JPG] command

   Open [JPG] command (File menu)

Use this command to load parameters and a bitmap file that were saved in jpeg format.  There is an
option in the file-type box to load only the bitmap too.  This replaces the Open command for those
who need a smaller sized bitmap file.  Note: the last files list doesn't keep track of images loaded in
JPEG format.

3.6.5 Open [PNG] command

   Open [PNG] command (File menu)

Use this command to load parameters and a bitmap file that was saved in png format.  There is an
option in the file-type box to load only the bitmap too.  This replaces the Open command for those
who need a smaller sized bitmap file.  Note: the last files list doesn't keep track of images loaded in
PNG format.
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3.7 Save Other

3.7.1 Parameters command

   Save Parameters command (File menu)

Use this command to save all data elements for the current image in a data file [.mn6].

3.7.2 Palette command

   Save Palette command (File menu)

Use this command to save a palette for the current image in a palette file [.pqz].  Also saves the
Coloring Filter used for surface mapping.

3.7.3 Texture command

   Save Texture command (File menu)

Use this command to save the variables that make up the texture and noise parameters for the
current figure.  This also saves the palette, coloring filter, orbit trap and coloring options in the
texture file [qtx].

3.7.4 Save  As [JPG] command

   Save As [JPG] command (File menu)

Use this command to save the parameters and active bitmap in jpeg format.  There is an option in
the file-type box to save only the bitmap too.  This replaces the Save and Save As command for
those who need a smaller sized bitmap file.  Note: the last files list doesn't keep track of images
saved in JPEG format.

3.7.5 Save  As [PNG] command

   Save As [PNG] command (File menu)

Use this command to save the parameters and active bitmap in png format.  There is an option in the
file-type box to save only the bitmap too.  This replaces the Save and Save As command for those
who need a smaller sized bitmap file.  Note: the last files list doesn't keep track of images saved in
PNG format.

3.8 Import

3.8.1 Palette command

   Import -> Palette [MAP] command (File menu)



File Menu 21

© 2011 -- Mystic Fractal

Use this command to load a Fractint-type map file.  The palette in the map file replaces the currently
selected palette.

3.9 Export

3.9.1 Save As [OBJ] command

   Export -> Save  as  [OBJ] command (File menu)

Use this command to save a 3-D fractal as a true 3-D object.  This uses John C. Hart's Implicit
code (quaternion Julia Set server) to polygonize a 3-D fractal formula, and then writes the triangles
to a Wavefront object file.  The higher the precision, the smoother the finished object becomes, but
the larger the object file and the greater the memory requirements.  Precision is set with the Export
Steps variable in the initial 3-D generator values window, where precision=10/Export Steps.  It is
useful to monitor memory used while exporting an object as too great a precision can easily exhaust
all available system memory and force the program to use virtual memory which is very slow in this
case.  Use the task manager to view physical memory used and halt the export if necessary before it
reaches the simplification stage.  A rule of thumb is to stop the export if physical memory used
exceeds 65% before simplifying.  (The simplification stage will use an extra 20-30% physical
memory.) 

After entering the name of the object in the file requester, you click on a starting point where the
exporter can begin mapping the 3-D fractal.  The starting point must lie on a solid (non-empty) part
of the 3-D fractal.
    
Note: zooming is supported, based on the min and max values of x, y and z space, to the depth the
3-D generator is capable of resolving in fixed-step mode.  (See Distance Estimator for more
information on fixed-step mode.)  Most of the time you need to reduce Z Max (in the initial values 
dialog)  to a value <=0, then view the results in Bryce or some other 3D imaging program.  Be sure
to turn off the Simplify option, as it is not very compatible with zoom meshes, and the export will
probably slow down to a crawl if the option is enabled.  The final value of Z Max may vary from 0
to -1.0, whatever value is needed to reduce the backside of the mesh to a minimum.  It helps to
reduce iterations to less than 8 when exporting Mandelbulbs.  Zooming and exporting are now
supported for Mandelboxes, though you need to be very selective for the starting point, and not all
of an entire Mandelbox may be exported due to discontinuities in the box.   (Saving the zbuffer is the
only option that works with Mandelboxes that contains the entire box, unless you reduce iterations
to a minimum which destroys most of the box's surface detail.)  Once exported to Bryce, change the
rotation angle to 0,45,0 or whatever angle is required to view only the front side of the mesh (or
portions of the mesh where the backside is not present or hidden.)  Note: the exported object is the
mirror image of the image seen in the draw window, unless you view the image in Mirror Mode.  

Tip: Since the number of Export Steps varies with every exported object, you may need to adjust
the number of Export Steps several times before you get an optimum mesh.  To avoid having to
redraw the image repeatedly while adjusting Export Steps, turn off menu  option Image/Auto/
Redraw.  As the number of Export Steps goes up, the space occupied by the 3-D fractal may
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increase slightly due to increased resolution, so draw the image initially with as many Resolution
steps as practical to more precisely define the 3-D fractal's boundaries.

3.9.2 Simplify option

   Export -> Simplify option (File menu)

With this option selected (default on) if the Save as OBJ or Save as STL command is executed the
resulting polygon mesh is simplified according to Garland's QSlim algorithm before being output as a
Wavefront obj file or stl file. 

3.9.3 Constrained option

Export -> Constrained option (File menu)

Use this option when you want the exported object to be constrained or truncated by the x/y/z
ranges set in the 3-D Generator Initial Values window.  Useful when exporting zoomed-in figures or
where the z ranges have been modified from their default -2/2 values.  This option automatically
disables the Simplify option when selected (though that option can be reselected afterwards if
desired), as the Simplify option in conjunction with zoomed-in x/y values can slow up export
processing appreciably.

3.9.4 Save Zbuffer [OBJ] command

Export -> Save  Zbuffer  [OBJ] command (File menu)

Use this command to save the zbuffer to a Wavefront object file.  Useful mainly for exporting parts
of a fractal object that have been zoomed in on when the object is too large to export using the
polygonizing commands, such as the case with Mandelbox zooms.  Caveats:  this is capable of
generating very large files, depending on the image size, which Bryce may not be able to load. 
Choose a smaller image size to reduce the file size.  Since zbuffers only hold the front face of a 3-D
object, you won't be able to rotate the object much in Bryce.  The initial rotation angle for this type
of export object is approximately (0,45,180) in Bryce 6 coordinates, though this could vary with the
angles used to generate the zbuffer and the version of Bryce you have.  Note: the translation from
zbuffer to .obj file is far from perfect and works best when the zoom is shallow or when all edges of
the object are close together in z space.  

3.9.5 Set Zbuffer Threshhold

Export -> Set Zbuffer Threshhold command (File menu)

Here you have the option to limit the mapping of adjacent zbuffer faces to whatever the threshold is set
(default is  .1).  This is useful to eliminate irregular oversized faces that may occur when adjacent faces
in the zbuffer are too far apart, as in a deep zoom and there exist undefined pockets in the zbuffer.  A
smaller value than .1 is more constrictive, while a threshhold larger than .1 may allow more "skewed"
faces to appear in the exported object file.  
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3.9.6 Save As [POV] command

   Export -> Save  as  [POV] command (File menu)

Use this command to save a 3-D fractal as a true 3-D object.  This uses John C. Hart's Implicit
code (quaternion Julia Set server) to polygonize a 3-D fractal formula, and then outputs the triangles
to a pov file.  The pov file is written as a simple scene, the triangles part of a "union" object, with
camera and lighting elements compatible with POV 3.5.  This can be used as a starting point for
more complex compositions.  The higher the precision, the smoother the finished object becomes,
but the larger the object file and the greater the memory requirements.  Precision is set with the
Export Steps variable in the initial 3-D generator values window, where precision=10/Export Steps.
It is useful to monitor memory used while exporting an object as too great a precision can easily
exhaust all available system memory and force the program to use virtual memory which is very slow
in this case.  Use the task manager to view physical memory used.

After entering the name of the object in the file requester, you click on a starting point where the
exporter can begin mapping the 3-D fractal.  The starting point must lie on a solid (non-empty) part
of the 3-D fractal.
    
Note: zooming is supported, based on the min and max values of x, y and z space, to the depth the
3-D generator is capable of resolving in fixed-step mode.  (See Distance Estimator for more
information on fixed-step mode.)  Most of the time you need to reduce Z Max (in the initial values 
dialog)  to a value <=0, then view the results in Bryce or some other 3D imaging program.  Be sure
to turn off the Simplify option, as it is not very compatible with zoom meshes, and the export will
probably slow down to a crawl if the option is enabled.  The final value of Z Max may vary from 0
to -1.0, whatever value is needed to reduce the backside of the mesh to a minimum.  It helps to
reduce iterations to less than 8 when exporting Mandelbulbs.  Zooming and exporting are now
supported for Mandelboxes, though you need to be very selective for the starting point, and not all
of an entire Mandelbox may be exported due to discontinuities in the box.   (Saving the zbuffer is the
only option that works with Mandelboxes that contains the entire box, unless you reduce iterations
to a minimum which destroys most of the box's surface detail.)  Once exported to Bryce, change the
rotation angle to 0,45,0 or whatever angle is required to view only the front side of the mesh (or
portions of the mesh where the backside is not present or hidden.)  Note: the exported object is the
mirror image of the image seen in the draw window, unless you view the image in Mirror Mode.  

Tip: Since the number of Export Steps varies with every exported object, you may need to adjust
the number of Export Steps several times before you get an optimum mesh.  To avoid having to
redraw the image repeatedly while adjusting Export Steps, turn off menu  option Image/Auto/
Redraw.  As the number of Export Steps goes up, the space occupied by the 3-D fractal may
increase slightly due to increased resolution, so draw the image initially with as many Resolution
steps as practical to more precisely define the 3-D fractal's boundaries.

3.9.7 Smooth option

   Export -> Smooth option (File menu)
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With this option selected (default on) smooth normals are calculated for the POV triangle mesh and
the polygonized object is output as a POV mesh with smooth_triangles.  Effective when the Save as
POV command is executed.

3.9.8 Set Max Faces command

   Export -> Set Max Faces command (File menu)

Here you can set the target face size for a Wavefront object, if the Simplify option is selected.  The
face size can range from 1000 to 5,000,000 faces.  This allows you to reduce the size of the
Wavefront object file by a factor of 10 or more and still retain the essential image detail.  Use
smoothing in Bryce to eliminate most of the triangle artifacts.  Before exporting the polygon as an obj
file, it helps to make the mesh resolution as high as practical by increasing the Export Steps size in
the initial 3-D generator values window to a suitable value.  This varies with the complexity of the 3-
D figure.  The face size limits the object file size by reducing faces on the polygon until the face limit
is reached, so you never export a polygon with more than n-size faces.  It's possible that there could
be fewer faces than the face limit, and in that case no mesh reduction is performed.  But usually you'll
see a dramatic reduction in object faces (and obj file size) if the Export Steps size is set to a value
greater than 200 (the startup default).

3.9.9 Save As [STL] command

  Export -> Save As [STL] command (File menu)

Use this command to save a 3-D fractal as a true 3D object.  This uses John C. Hart's Implicit code
(quaternion Julia Set server) to polygonize a 3-D fractal formula, and then writes the triangles to a
STL solid file.  STL files are used with 3D printers and other machinery.  The higher the precision,
the smoother the finished object becomes, but the larger the object file and the greater the memory
requirements. The higher the precision, the smoother the finished object becomes, but the larger the
object file and the greater the memory requirements.  Precision is set with the Export Steps variable
in the initial 3-D generator values window, where precision=10/Export Steps.  It is useful to monitor
memory used while exporting an object as too great a precision can easily exhaust all available
system memory and force the program to use virtual memory which is very slow in this case.  Use
the task manager to view physical memory used.

After entering the name of the object in the file requester, you click on a starting point where the
exporter can begin mapping the 3-D fractal.  The starting point must lie on a solid (non-empty) part
of the 3-D fractal.
    
Note: zooming is supported, based on the min and max values of x, y and z space, to the depth the
3-D generator is capable of resolving in fixed-step mode.  (See Distance Estimator for more
information on fixed-step mode.)  Most of the time you need to reduce Z Max (in the initial values 
dialog)  to a value <=0, then view the results in Bryce or some other 3D imaging program.  Be sure
to turn off the Simplify option, as it is not very compatible with zoom meshes, and the export will
probably slow down to a crawl if the option is enabled.  The final value of Z Max may vary from 0
to -1.0, whatever value is needed to reduce the backside of the mesh to a minimum.  It helps to
reduce iterations to less than 8 when exporting Mandelbulbs.  Zooming and exporting are now
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supported for Mandelboxes, though you need to be very selective for the starting point, and not all
of an entire Mandelbox may be exported due to discontinuities in the box.   (Saving the zbuffer is the
only option that works with Mandelboxes that contains the entire box, unless you reduce iterations
to a minimum which destroys most of the box's surface detail.)  Once exported to Bryce, change the
rotation angle to 0,45,0 or whatever angle is required to view only the front side of the mesh (or
portions of the mesh where the backside is not present or hidden.)  Note: the exported object is the
mirror image of the image seen in the draw window, unless you view the image in Mirror Mode.  

Tip: Since the number of Export Steps varies with every exported object, you may need to adjust
the number of Export Steps several times before you get an optimum mesh.  To avoid having to
redraw the image repeatedly while adjusting Export Steps, turn off menu  option Image/Auto/
Redraw.  As the number of Export Steps goes up, the space occupied by the 3-D fractal may
increase slightly due to increased resolution, so draw the image initially with as many Resolution
steps as practical to more precisely define the 3-D fractal's boundaries.

3.9.10 Save As [WRL] command

   Export -> Save  as  [WRL] command (File menu)

Use this command to save a 3-D fractal as a true 3-D object.  This uses John C. Hart's Implicit
code (quaternion Julia Set server) to polygonize a 3-D fractal formula, and then writes the triangles
to a virtual reality file.  The higher the precision, the smoother the finished object becomes, but the
larger the object file and the greater the memory requirements.  Precision is set with the Export
Steps variable in the initial 3-D generator values window, where precision=10/Export Steps.  It is
useful to monitor memory used while exporting an object as too great a precision can easily exhaust
all available system memory and force the program to use virtual memory which is very slow in this
case.  Use the task manager to view physical memory used.

After entering the name of the object in the file requester, you click on a starting point where the
exporter can begin mapping the 3-D fractal.  The starting point must lie on a solid (non-empty) part
of the 3-D fractal.
    
Note: zooming is supported, based on the min and max values of x, y and z space, to the depth the
3-D generator is capable of resolving in fixed-step mode.  (See Distance Estimator for more
information on fixed-step mode.)  Most of the time you need to reduce Z Max (in the initial values 
dialog)  to a value <=0, then view the results in Bryce or some other 3D imaging program.  Be sure
to turn off the Simplify option, as it is not very compatible with zoom meshes, and the export will
probably slow down to a crawl if the option is enabled.  The final value of Z Max may vary from 0
to -1.0, whatever value is needed to reduce the backside of the mesh to a minimum.  It helps to
reduce iterations to less than 8 when exporting Mandelbulbs.  Zooming and exporting are now
supported for Mandelboxes, though you need to be very selective for the starting point, and not all
of an entire Mandelbox may be exported due to discontinuities in the box.   (Saving the zbuffer is the
only option that works with Mandelboxes that contains the entire box, unless you reduce iterations
to a minimum which destroys most of the box's surface detail.)  Once exported to Bryce, change the
rotation angle to 0,45,0 or whatever angle is required to view only the front side of the mesh (or
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portions of the mesh where the backside is not present or hidden.)  Note: the exported object is the
mirror image of the image seen in the draw window, unless you view the image in Mirror Mode.  

Tip: Since the number of Export Steps varies with every exported object, you may need to adjust
the number of Export Steps several times before you get an optimum mesh.  To avoid having to
redraw the image repeatedly while adjusting Export Steps, turn off menu  option Image/Auto/
Redraw.  As the number of Export Steps goes up, the space occupied by the 3-D fractal may
increase slightly due to increased resolution, so draw the image initially with as many Resolution
steps as practical to more precisely define the 3-D fractal's boundaries.

3.9.11 Save As [DXF] command

   Export -> Save  as  [DXF] command (File menu)

Use this command to save a 3-D fractal as a true 3-D object.  This uses John C. Hart's Implicit
code (quaternion Julia Set server) to polygonize a 3-D fractal formula, and then writes the triangles
to an AutoCad dxf file.  The higher the precision, the smoother the finished object becomes, but the
larger the object file and the greater the memory requirements.  Precision is set with the Export
Steps variable in the initial 3-D generator values window, where precision=10/Export Steps.  It is
useful to monitor memory used while exporting an object as too great a precision can easily exhaust
all available system memory and force the program to use virtual memory which is very slow in this
case.  Use the task manager to view physical memory used.

After entering the name of the object in the file requester, you click on a starting point where the
exporter can begin mapping the 3-D fractal.  The starting point must lie on a solid (non-empty) part
of the 3-D fractal.
    
Note: zooming is supported, based on the min and max values of x, y and z space, to the depth the
3-D generator is capable of resolving in fixed-step mode.  (See Distance Estimator for more
information on fixed-step mode.)  Most of the time you need to reduce Z Max (in the initial values 
dialog)  to a value <=0, then view the results in Bryce or some other 3D imaging program.  Be sure
to turn off the Simplify option, as it is not very compatible with zoom meshes, and the export will
probably slow down to a crawl if the option is enabled.  The final value of Z Max may vary from 0
to -1.0, whatever value is needed to reduce the backside of the mesh to a minimum.  It helps to
reduce iterations to less than 8 when exporting Mandelbulbs.  Zooming and exporting are now
supported for Mandelboxes, though you need to be very selective for the starting point, and not all
of an entire Mandelbox may be exported due to discontinuities in the box.   (Saving the zbuffer is the
only option that works with Mandelboxes that contains the entire box, unless you reduce iterations
to a minimum which destroys most of the box's surface detail.)  Once exported to Bryce, change the
rotation angle to 0,45,0 or whatever angle is required to view only the front side of the mesh (or
portions of the mesh where the backside is not present or hidden.)  Note: the exported object is the
mirror image of the image seen in the draw window, unless you view the image in Mirror Mode.  

Tip: Since the number of Export Steps varies with every exported object, you may need to adjust
the number of Export Steps several times before you get an optimum mesh.  To avoid having to
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redraw the image repeatedly while adjusting Export Steps, turn off menu  option Image/Auto/
Redraw.  As the number of Export Steps goes up, the space occupied by the 3-D fractal may
increase slightly due to increased resolution, so draw the image initially with as many Resolution
steps as practical to more precisely define the 3-D fractal's boundaries.

3.9.12 Save As [PLY] command

   Export -> Save  as  [PLY] command (File menu)

Use this command to save a 3-D fractal as a true 3-D object.  This uses John C. Hart's Implicit
code (quaternion Julia Set server) to polygonize a 3-D fractal formula, and then writes the triangles
to a Ply (polygon format) object file.  The higher the precision, the smoother the finished object
becomes, but the larger the object file and the greater the memory requirements.  Precision is set
with the Export Steps variable in the initial 3-D generator values window, where precision=10/
Export Steps.  It is useful to monitor memory used while exporting an object as too great a precision
can easily exhaust all available system memory and force the program to use virtual memory which is
very slow in this case.  Use the task manager to view physical memory used.

After entering the name of the object in the file requester, you click on a starting point where the
exporter can begin mapping the 3-D fractal.  The starting point must lie on a solid (non-empty) part
of the 3-D fractal.
    
Note: zooming is supported, based on the min and max values of x, y and z space, to the depth the
3-D generator is capable of resolving in fixed-step mode.  (See Distance Estimator for more
information on fixed-step mode.)  Most of the time you need to reduce Z Max (in the initial values 
dialog)  to a value <=0, then view the results in Bryce or some other 3D imaging program.  Be sure
to turn off the Simplify option, as it is not very compatible with zoom meshes, and the export will
probably slow down to a crawl if the option is enabled.  The final value of Z Max may vary from 0
to -1.0, whatever value is needed to reduce the backside of the mesh to a minimum.  It helps to
reduce iterations to less than 8 when exporting Mandelbulbs.  Zooming and exporting are now
supported for Mandelboxes, though you need to be very selective for the starting point, and not all
of an entire Mandelbox may be exported due to discontinuities in the box.   (Saving the zbuffer is the
only option that works with Mandelboxes that contains the entire box, unless you reduce iterations
to a minimum which destroys most of the box's surface detail.)  Once exported to Bryce, change the
rotation angle to 0,45,0 or whatever angle is required to view only the front side of the mesh (or
portions of the mesh where the backside is not present or hidden.)  Note: the exported object is the
mirror image of the image seen in the draw window, unless you view the image in Mirror Mode.  

Tip: Since the number of Export Steps varies with every exported object, you may need to adjust
the number of Export Steps several times before you get an optimum mesh.  To avoid having to
redraw the image repeatedly while adjusting Export Steps, turn off menu  option Image/Auto/
Redraw.  As the number of Export Steps goes up, the space occupied by the 3-D fractal may
increase slightly due to increased resolution, so draw the image initially with as many Resolution
steps as practical to more precisely define the 3-D fractal's boundaries.
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3.9.13 Set Max Vertices command

   Set Max Indices (File menu)

Use this command to set the maximum number of indices that are allocated by the polygonizing
routine.  Default is 5,000,000 indices.  Use less to limit the amount of memory used while
polygonizing.  Use more if necessary for higher resolution.  Note:  unless you have an application that
can use very large object files, there's a limit to how much resolution is obtainable with the
polygonizing routine.  Bryce6 has problems with object files produced by Montezuma that are much
larger than 75MB (2 million faces) on Windows 7.

3.10 File 1, 2, 3, 4, 5, 6 command

   1, 2, 3, 4, 5, 6 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last six drawings
you closed.  Choose the number that corresponds with the drawing you want to open.

3.11 Exit command

  Exit command (File menu)

Use this command to end your Montezuma session.  You can also use the Close command on the
application Control menu.  Note: if you choose to exit while plotting, the program does not
terminate, but stops the plotting so the program can be safely exited.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4

4 Edit Menu

  Edit menu commands

The Edit menu offers the following commands:

Undo Undo last edit, action or zoom.
Copy     Copy the active view and put it on the Clipboard.
Clip     Define area of view and copy to clipboard.
Paste     Insert Clipboard contents.
Copy Data     Copy fractal data to buffer.
Paste Data     Paste data from copy buffer.
Formula/Type     Edit formula/type data.
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Drawing Parameters Edit drawing window parameters.
Size     Sets the image size.
3-D Generator     Edit 3-D generator parameters.
Ray-Tracing Variables     Edit lighting and viewpoint variables.
Palette Editor Edit palette.
Text     Edit and add text to drawing.
Preferences    Startup preferences and defaults.

4.1 Undo command

   Undo command (Edit menu)

Use this command to undo the last action.  An image can be continued after an undo, if continue was
enabled before the last action.  Color cycling is disabled after using Undo, though.
Undo is disabled for bitmaps whose width is not a multiple of 8.

Shortcut
Keys: CTRL+Z

4.2 Copy command

   Copy command (Edit menu)

Use this command to copy the active view to the clipboard.  The entire view is copied to the
clipboard.

Shortcut
Keys: CTRL+C

4.3 Clip command

   Clip command (Edit menu)

Use this command to copy a part of the active view to the clipboard.  A zoom box is used to select
the part to be copied.  Click outside the view frame or press escape to exit this option.

Shortcut
Keys: CTRL+L

4.4 Paste command

   Paste command (Edit menu)

Use this command to paste from the clipboard.  The clipboard must contain a bitmap.  If the bitmap



Montezuma Application Help30

© 2011 -- Mystic Fractal

is larger than the view, it is clipped.  The zoom cursor is used to set the left/top corner in the view
where the bitmap will be pasted.  Click outside the view frame or press escape to exit this option.

Shortcut
Keys: CTRL+V

4.5 Copy Data command

   Copy Data command (Edit menu)

Use this command to copy the fractal data for the active view to the file "c:\zcopy.mn6".  The current
palette for the view is also copied.

Shortcut
Keys: CTRL+F

4.6 Paste Data command

   Paste Data command (Edit menu)

Use this command to paste the data in the file "c:\zcopy.mn6" to the active view.

Shortcut
Keys: CTRL+R

4.7 Formula/Type Window

    Formula/Type Window

From the drop-down list in Fun #1 you choose the Montezuma formula to be used for the plot.

Clicking on Random fun#1, a formula is chosen at random (from the first 20 built-in formulas) for fun
#1.

The 'n' and 'm' boxes are used to enter the exponent(s) for the selected formula.

The Type n and Type m drop-down boxes define the quad math used in calculating the exponential
parts of the formula.  There are six types of quad math to choose from, Quaternion, Hypernion,
CompQuat (complexified quaternion), Juliat, Mandelbulb sine and Mandelbulb cosine.  You can mix
types in formulas where both Type n and Type m math are used, producing fractal characteristics
common to both math types.  Type n math is used for powers of n and Type m math is used for
powers of m.  (In some of the formulas,  where there is no m-power term, only Type n quad math is
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used,.)  

The Mandelbulb types are based on the Triplex algebra developed on fractalforums.com.  This type
of algebra is purely experimental.  Multiplication is communicative but not associative. 

The Title text box is used with the hot key 'T' to annotate a picture with text.  Use the Edit/Text
command to change font, text color or format text into multiple lines.  Text in this box is not saved in
a picture's data file, but once entered the same text can be used over and over for different pictures.
This is useful for adding copyright/author info to batches of pictures.  Since the same title text may be
used many times, it is shared among views and saved in the file "prefs.txt" in Montezuma's startup
directory.

Click on the Okay button to use the formulas currently displayed in the window, or Cancel to exit
the window without making any changes.  Click on Apply to apply a new formula, etc. without
closing the Formula window.

The UD button is enabled when built-in formula 'C1' is selected.  This opens a window where you
can modify the trig functions which make up the basic Mandelbulb formula, and create interesting
Mandelbulb-like variations.

The  Hybrid button is enabled when built-in formula 'C2' is selected.  This opens a window where
you can combine two formulas to create a "hybrid" fractal, such as a Mandelbox Mandelbulb.

The Reset button returns all boxes and slider values to their original values when the window was
opened.

4.8 User-Defined Mandelbulb

  User-Defined Mandelbulb

Here you can modify the trig functions that compose the basic Mandelbulb formula developed by
Daniel White and Paul Nylander.  The basic formula (sine version) is 

z1=x
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1
+z

1
+c
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z0=x
0
+y

0
+z

0

In QuaSZ parser terms the formula can be represented as:

n=l# ; Arg limit value
rfun ; begin real values
z1 = imaj(z) ; third component of z
r = sqrt (x#*x# + y#*y# + z1*z1 +.0000001)
phi = n * asin(z1 / r)
w = n * theta(z)
t2 = cos(phi)
t1 = r^n
x = t1 * t2 * cos(w)
y = t1 * t2 * sin w)
z1 = t1 * sin(phi)
rend ; end real values
z = x  + y * i  + z1 * j + c#

For the purposes of Montezuma's user-defined Mandelbulb formula, the trig functions have been
replaced thus:

phi = n * f1(z1 / r)
t2 = f9(phi)
x = t1 * t2 * f2(w)
y=t1 * t2 * f3(w)
z1=t1 * f4(phi)

where f1 to f9 are one of  14 user-defined trig functions:

0; sin(v) 1; sinh(v) 2; cos(v) 3; cosh(v) 4; tan(v)
5; tanh(v) 6; exp(v) 7; vers(v) 8; cotan(v) 9; cotanh(v)
10; asin(v) 11; acos(v) 12 atan(v) 13; acotan(v)

and n is the value entered in the 'n' box

4.9 Hybrid Fractal

   Hybrid Fractal

Here you select two built-in formulas and combine them to form one hybrid fractal.  Each formula can
have exclusive values for algebra type, n and m.  To combine the formulas you enter how many iterations
you want each formula to be iterated, and for fun#1 when to start iterating it and how many iterations
before switching to fun#2. An alternate distance estimator (DE) may also be selected, as well as an
alternate ambient occlusion (AO) model.
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4.10 Parameters Window

    Drawing Parameters Window

The Size slider controls the overall size of the picture.  The Size slider sets the horizontal resolution,
while the vertical resolution is then scaled according to the full-screen VGA ratio, 4 to 3(1:1 if that
aspect is selected through the Auto menu.)  The Sector slider controls which of 4 sectors the picture
will be drawn in, if the Size is less than or equal to (the full-screen horizontal resolution)/2. 
Otherwise the picture is centered according to the full-screen dimensions.  This allows you to show
zooms of a particular function by using different sectors, or show the affect of different plotting
options.  Each sector is erased individually.  Note: if you try to continue a plot in a different sector
than you started with, the plot will continue in the original sector.  The Thumbnail button next to the
Size slider is used to set a thumbnail size quickly.  The thumbnail size toggles between 1/4 and 1/8 of
the horizontal screen resolution, e.g. 200X150 or 100X75 for an 800X600 screen.

Select the Okay button to start a new plot from column 1.  Select the Continue button to continue a
plot at the row it left off, if it is not a complete drawing. 

The Reset button returns all boxes and slider values to their original values when the window was
opened.  

Related Topic:
3-D Generator describes the 3-D generator's data-collection window.

4.11 Size command

    Size (Edit menu)

This allows you to set the drawing area for a picture, independent of the Windows screen size.  It
also shows which size is currently in use.  The aspect for the drawing is based on the ratio of X
(horizontal width) to Y (vertical height.)  The size of an image can range in standard 4/3 and 1/1
aspects from 160X120 to 3840X2880 or you can choose a custom XY size.  The custom setting
allows for any size/aspect that system memory will permit.   The minimum size for an image is
40X30.  Note: if the image is less than 100 width, the aspect must be 4/3 for solid guessing to work
properly.

4.12 3-D Generator

4.12.1 Initial 3-D Generator Values

    Initial Values for 3-D Generator Window

This is the data-collection window for the 3-D generator.  

Min X, Max X, Min Y and Max Y are the spatial variables for framing the 3-D object.  These are
usually updated automatically when you use the zoom box.  Min Z and Max Z define the three-
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dimensional space that is used to map the 3-D image.  Normally Min Z is the negative of Max Z, but
Min Z can be adjusted in the positive direction to shear off the front of the 3-D object.  This has the
effect of exposing the insides of a 3-D fractal set.  

Complex constants are cr, ci, and cj.  

Three rotate variables determine the 3-D angle of rotation. 

Resolution acts as a focusing variable to increase the surface detail of a fractal image.  Too much
detail may interfere with the esthetics of an image (making it look 'busy'), while too little detail can
make an image look unfocused.  Generally a value from 3000 to 10000 is sufficient for bitmaps up
to 4800 pixels wide.  Higher values may slow processing while adding little to the appeal of an
image.

Stepscale and Fine Steps are pitch adjustments that bear on the quality of the plot at the expense of
lengthier calculations.  A lower stepscale reduces 'stepping' artifacts that the distance estimator may
introduce from overshooting the 3-D boundary.  A lower stepscale also proportionately increased
processing time, so the lowest stepscales (.01 to .3) should only be used for the final image
processing.

Fine Tune is a scaling variable that compensates for inaccuracies in  the derivative used to calculate
the distance estimator.  Small amounts can sometimes allow you to increase the stepscale without
affecting image quality.
 
Use the Random Rotate button to set random values (0-360) for the Rotation variables.

The FOV variable is used to set field of view or perspective.  A higher value decreases the field of
view.

When you click on Okay or Apply, the 3-D generator looks at the Fun#1 gadget in the Edit/
Formula window.  That function is iterated for its escape time, then the results are ray-traced in any
3-D object that may be created.

Stepscale, Fine Tune and FOV are only used with the distance estimator method.  

Export Steps determine the resolution of the exported quaternion.  More steps will be required for
zoomed-in objects.  

4.12.2 Ray-Tracing Variables

    Ray-Tracing Window

The LightPoint variables (lightx thru lightz) determine the direction of the light source used in the ray-
tracing algorithm.  The ViewPoint represents the angle, at which the object is ray-traced, which can
affect Phong highlights greatly.  This has no effect on the camera view.

The Lighting variables shininess, highlight, gamma and ambient are used to adjust ambient light and
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highlights.  The ranges for these variables appear beside their label.  Decreasing the shininess value
increases light reflected by the fractal and the apparent sheen on the fractal's surface.  The ambient
value controls the amount of ambient light that illuminates the fractal.  The highlight value increases or
decreases the specular (Phong) highlighting, while the gamma value increases or decreases the
intensity of the light source's illumination.  Once a plot is started, the lighting variables and light point
can be changed without redrawing the fractal.

AO adds ambient occlusion shadowing to the image, making the image appear to have more depth. 
The Contrast variable increases contrast between light and dark areas of the image, boosting overall
brightness of the image also.
 

Click the Apply button to redisplay a plot after changing the lighting variables or light point.  Click
the Okay button to close the Ray-Tracing Window, applying new settings, if the variables were
modified.  Click on Cancel to revert to the state that existed when the ray-tracing window was
opened.  Click on Defaults to set the lighting and viewpoint variables to the built-in defaults for these
variables.

4.13 Palette command

    Palette command (Edit menu)

Use the palette editor to modify the palette(s) in use.  

It is important to realize that palettes are software-simulated in Montezuma (since 24-bit color
supports no hardware palettes), so color cycling and palette switching are not fast operations as with
a 256-color system that supports palettes. 

There are copy and spread options to smooth or customize the curent palette in Montezuma.  You
can then save the palette in a .pqz file, or by saving the entire function and bitmap.

Colors are shown in 8 groups of 32 colors.  With Montezuma, a palette is actually 65280 colors,
with each succeeding color (except the last) followed by 255 colors that are evenly spread from one
color to the next.
  
Use the RGB-slider controls to edit any color in the palette.  Select Copy to copy any color to
another spot in the palette. Select Spread to define a smooth spread of colors from the current spot
to another spot in the palette.  Copy and Spread take effect immediately when you select another
spot with the mouse button.  You can cancel the operation with the Cancel button.  In Montezuma,
colors do not cycle smoothly when you adjust the RGB/HSV sliders.  This would be too slow with
true color.  The Map button is used to map color changes to an image after you are done adjusting
the sliders.  In the HSV mode, color spreads are based on HSV values instead of RGB values,
which in some cases results in brighter color spreads.

Right-click on any point on the main window and the palette color for that pixel will be displayed in
the palette editor.  You can use any of the color-cycling keys (after clicking on the main window) to
see the effects of the cycling in the palette editor window.   Note:  color cycling and color-selection-
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from-pixel only works when the image has been drawn in the current session.  If you load a pre-
existing image file, you must redraw it to cycle colors, etc.  Anti-aliasing, and the composite figure
option also disable color cycling.

Use Reset to reset the colors of the palette in use, to where it was before it was cycled or modified.
Note: if you change palettes with one of the function keys, any modifications to a previous palette
are unaffected by the Reset button.

Use Reverse to reverse the order of the colors in the palette.  This affects only those colors in the
start-color to end-color range.

Use Neg to create a palette that is the complement of the current palette.

Use SRG to switch the red and green components of all palette colors.
Use SRB to switch the red and blue components of all palette colors.  SRB and SRG are disabled in
HSV mode.  You can use these buttons to form eight different palettes by repeatedly switching red,
green and blue components.

Use the Random palette button to randomize the current palette.  The Randomize variables, rmin,
rmax, bmin, bmax, gmin, and gmax act as limits that are applied after the palette after initial
randomizing, to make the palette conform to the desired spectrum of colors.

Note: unless you click on Reset before exiting the editor, changes are permanent to the palette
edited, no matter which way you close the editor (Okay button or close box.)

4.13.1 Reverse button

    Reverse button

Use Reverse to reverse the order of the colors in the palette.  This affects only those colors in the
start-color to end-color range.  This is useful for reversing divide-by-eight palettes, etc., for orbit-
trap pictures that require a reversed palette.

4.13.2 Neg Button

    Neg button

Use Neg to create a palette that is the complement of the current palette.

4.13.3 Map Button

    Map button

In Montezuma, colors do not cycle smoothly when you adjust the RGB/HSV sliders.  This would be
too slow with true color.  The Map button is used to map color changes to an image after you are
done adjusting the sliders.
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4.13.4 H/R Button

    H/R button

Change from HSV to RGB mode or back.  In the HSV mode, color spreads are based on HSV
values instead of RGB values, which in some cases results in brighter color spreads.

4.13.5 Spread Button

    Spread button

Select Spread to define a smooth spread of colors from the current spot to another spot in the
palette.

4.13.6 Copy Button

    Copy button

Select Copy to copy any color to another spot in the palette.

4.13.7 SRG Button

    SRG button

Use SRG to switch the red and green components of all palette colors.  This is for RGB mode only.

4.13.8 SRB Button

    SRB button

Use SRG to switch the red and blue components of all palette colors.  This is for RGB mode only.

4.13.9 Okay Button

    Okay button

Click on Okay to exit the palette editor, applying unmapped color changes to picture (if color-
cycling is enabled.)

4.13.10 Reset Button

    Reset button

Use Reset to reset the colors of the palette in use, to where it was before it was cycled or modified.
Note: if you change palettes with one of the function keys, any modifications to a previous palette
are unaffected by the Reset button.
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4.13.11 Cancel Button

    Cancel button

You can cancel a copy or spread operation with the Cancel button.

4.13.12 Red Slider

    Red slider

Use the RGB/HSV-slider controls to edit any color in the palette.

4.13.13 Green Slider

    Green slider

Use the RGB/HSV-slider controls to edit any color in the palette.

4.13.14 Blue Slider

    Blue slider

Use the RGB/HSV-slider controls to edit any color in the palette.

4.13.15 Red edit box

    Red edit box

Shows red/hue value of selected color index.

4.13.16 Green edit box

    Green edit box

Shows green/saturation value of selected color index.

4.13.17 Blue edit box

    Blue edit box

Shows blue/value magnitude of selected color index.

4.13.18 Random Palette Button

    Random palette button

Use to create a random palette.  Fast way to define palettes.
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4.14 Edit Text command

    Text (Edit menu)

This allows you to edit text and font and apply it to a drawing.  Select the font button to set the font
style, size and color.  In the text window click on Okay to add a line of text to the current image. 
(You can add multiple lines of text too, up to 80 characters.)  The cursor will change to a crosshair. 
Position the cursor where you want the text to start and left-click the mouse.  Note: font and title text
are saved in the file "prefs.txt" in Montezuma's startup directory.  Title text can also be edited (as a
single line only) in the Edit/Formula window.

4.15 Preferences command

    Preferences (Edit menu)

Each time you use the Reset Defaults command, Montezuma restores data variables to built-in
defaults.  The Set Defaults button allows you to change some of the data variable defaults to
whatever the current settings are.  Some of the customizable variables include step, fine, formula,
viewpoint, lighting, rotational angles, Phong and x/y space.  (Iterations, Type, Constants, and a few
other variables are excluded to maintain compatibility with the 'G' command.)  The new Reset
defaults are saved in the file "prefs.txt" when you close the program (if the Defaults check box is
selected.)  The check boxes in the group "Save on Program Close" allow you to change the default
startup mode of a few Auto options, such as Auto Redraw, and the Random Setup variables.  By
keeping the boxes selected, Montezuma saves the last changes you make to these options.  If you
want to go back to the initial settings (the way Montezuma was packaged originally) you can click
on the Reset Defaults button.  This restores the data, Auto variables and random setup defaults.  

Use the Reset Dialog Positions button to reset all non-modal dialog positions to x/y positions that
will fit within a 640X480 screen.  Sometimes when you switch screen resolutions to a lower
resolution there might be dialogs that are off the screen and thus are inaccessible when reopened.  
This can happen too if the Registry key for the dialog position becomes corrupt.  (The program
keeps track of all non-modal dialogs' last positions in the Software portion of the Registry.)  Close
all open dialog windows you want to reset before using this command, or open a New draw
window before using the command.

Use the Default Directories tab to change the default directories for saved and loaded items in
Montezuma.  Click on the "…" button next to each default directory box, and use the folder
requester to pick a different directory, or create a new directory with the Make New Folder button.
The default directories are saved at program close in the Registry and reloaded when you next open
Montezuma.
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5 Image Menu

  Image menu commands

The Image menu offers the following commands:

Draw Draw the picture.
Draw Composite Draw composite from figures 1-4.
Plot To File Plot large bitmap images directly to png file.
Plot Files In Directory Disk render .mn6 files in working directory.
Auto Redraw    Redraw image on command.
Auto Clear     Clear drawing area before new plot.
Auto Dust     Remove isolated pixels and single-pixel threads.
Auto Sound Alert    Enable or turn off sound alerts.
Auto Remote Open remote automatically at startup.
Auto Time   Show time used to plot image.
Merge Sum     Merge current pixel color with previous color summing colors.
Merge And     Merge current pixel color with previous color anding colors.
Merge Or     Merge current pixel color with previous color oring colors.
Merge High    Merge current pixel color with previous color by choosing highest rgb.
Merge Low     Merge current pixel color with previous color by choosing lowest rgb.
Merge Back     Merge current pixel color with previous color by excluding background
color.
Merge Diff     Merge current pixel color with previous color by using difference of colors.

Hide Dialogs Hide dialogs for active drawing.
Show Dialogs    Show drawings for active drawing.
Abort     Abort drawing.
Continue     Continue drawing.
Zoom     Zoom into rectangle.
New View on Zoom New view on zoom.
Clone    Clone current view.
Cycle Colors Cycle colors.
Pilot     Use Pilot to rotate figure and alter key cubic variables.
Scan Scan Mandelbrot border for 3-D Julia set.
Ray Trace  Ray trace 3-D plot.
Reset->     Reset coordinates, current figure or all figures
Figure 1     Switch to figure one.
Figure 2     Switch to figure two.
Figure 3     Switch to figure three.
Figure 4     Switch to figure four.
Composite  Select figures to merge.
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5.1 Draw command

   Draw command (Image menu)

Use this command to draw or redraw the image for the current fractal variables.  Clicking inside the
draw window with the left-mouse button stops all plotting.  Use the Continue command to restart
plotting from the current column.

5.2 Draw Composite command

   Draw Composite command (Image menu)

Use this command to draw or redraw an image defined in the Composite command as a merging of
figures 1-4.  Clicking inside the draw window with the left-mouse button stops all plotting.  Continue
is disabled for this command.

5.3 Plot to file

   Plot to File (Image menu)

This allows you to plot a large bitmap directly to a .png file without the added system requirements
of keeping the whole bitmap in memory.  The Target group sets the bitmap resolution (width 800 to
14400.  Drawing aspect is that of the current image.)  Click on Okay to set the target file name and
start a new plot to file.  Note: the 3200X2400 bitmap size is suitable for 8 1/2X11 printouts at 320-
720 dpi.  The larger bitmap sizes are suitable for poster-size printouts.  This option is not available
with the merging options, or with anti-aliasing.  Also, solid guessing is disabled when using this
option.

5.4 Plot Files in Directory

   Plot Files in Directory (Pixel menu)

Allows you to plot a set of large bitmaps directly to a .png files without the added system
requirements of keeping any of the images in memory.  The Target group sets the bitmap resolution
(width 800 to 14400.  Drawing aspect is that of the current image.)  All data files (.mn6) in the
working directory are enlarged to this resolution.  Click on Okay to start.  Note: the 3200X2400
bitmap size is suitable for 8 1/2X11 printouts at 320-720 dpi.  The larger bitmap sizes are suitable
for poster-size printouts.  Merging, anti-aliasing and solid guessing are disabled when using this
option.

5.5 Auto

5.5.1 Redraw command

   Auto Redraw command (Image menu)

With this command disabled (on by default), redraw does not occur except when the Draw
command is executed, or Continue.  Most of the time you want to see the results of changing a
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parameter or mapping option, so redraw occurs automatically with parameter or mapping changes. 
Sometimes you want to change more than one parameter before redrawing the image.  So you need
to turn this option off then.

5.5.2 Clear command

   Auto Clear command (Image menu)

With this command enabled (on by default), the drawing area is cleared before starting a new plot. 
You can turn off this option when you want to see the effect of minor changes to parameters, as they
affect the plot pixel by pixel, or when setting up a multiple-layered fractal.  Note: when you disable
auto clear, no pre-image is drawn while the image is being calculated, and any background image
(loaded through Open [Jpeg] or Open [Png]) is retained.  You can use the shift-c command (hot
keys) to clear the drawing area at any time.

5.5.3 Dust command

   Auto Dust command (Image menu)

With this command enabled (on by default), single pixels and 3-D threads one pixel wide are
removed after ray tracing.  Sort of like the de-speckle filter in some image-processing programs.

5.5.4 Auto Alert command

   Auto Sound Alert command (Image menu)

A sound clip is issued when a drawing is completed or user-canceled.  By disabling this command
the completion exclamation is suppressed and also any alert that contains a message box.  Note:
some sound clips are automatically generated by Windows, or there is no text alert for a given error
condition.  In these cases the sound alert is unaffected by the Auto Alert command.

5.5.5 Auto Remote command

   Auto Remote command (Image menu)

With this command enabled (on by default), the remote is opened immediately at program startup.
Handy if you find the remote useful and don't want to click on the toolbar button each time the
program starts up.

5.5.6 Auto Time command

   Auto Time command (Image menu)

With this command enabled (on by default), the time that an image takes to plot is displayed when
the plot is complete.  Montezuma saves the condition of this option at session's end, so if you disable
it and close the program, the option will be disabled when you restart Montezuma.
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5.6 Merge Colors

5.6.1 Merge Sum command

   Merge Sum command (Image menu)

With this command enabled (off by default), current pixel color is not overwritten when a new image
is drawn.  Instead the colors are merged using a summing algorithm.  The auto-clear option must be
disabled and solid guessing off to choose this option.  This is useful to merge two or more separate
fractal images/types with the initial image(s) "bleeding" through.

5.6.2 Merge And command

   Merge And command (Image menu)

With this command enabled (off by default), current pixel color is not overwritten when a new image
is drawn.  Instead the colors are merged using an anding algorithm.  The auto-clear option must be
disabled and solid guessing off to choose this option.  This is useful to merge two or more separate
fractal images/types with the initial image(s) "bleeding" through.

5.6.3 Merge Or command

   Merge Or command (Image menu)

With this command enabled (off by default), current pixel color is not overwritten when a new image
is drawn.  Instead the colors are merged using an oring algorithm.  The auto-clear option must be
disabled and solid guessing off to choose this option.  This is useful to merge two or more separate
fractal images/types with the initial image(s) "bleeding" through.

5.6.4 Merge High command

   Merge High command (Image menu)

With this command enabled (off by default), current pixel color is not overwritten when a new image
is drawn.  Instead the colors are merged using the highest rgb values of both images.  The auto-clear
option must be disabled and solid guessing off to choose this option.  This is useful to merge two or
more separate fractal images/types with the initial image(s) "bleeding" through.

5.6.5 Merge Low command

   Merge Low command (Image menu)

With this command enabled (off by default), current pixel color is not overwritten when a new image
is drawn. Instead the colors are merged using the lowest rgb values of both images.  The auto-clear
option must be disabled and solid guessing off to choose this option.  This is useful to merge two or
more separate fractal images/types with the initial image(s) "bleeding" through.

5.6.6 Merge Back command

   Merge Back command (Image menu)
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With this command enabled (off by default), current pixel color is not overwritten when a new image
is drawn. Instead the colors are merged using the rgb components of the new image if the new color
index is not zero; else the old rgb values are retained.  The auto-clear option must be disabled and
solid guessing off to choose this option.  This is useful to merge two or more separate fractal images/
types with the initial image(s) "bleeding" through.

5.6.7 Merge Diff command

   Merge Diff command (Image menu)

With this command enabled (off by default), current pixel color is not overwritten when a new image
is drawn. Instead the colors are merged using the difference of the rgb values of both images.  The 
auto-clear option must be disabled and solid guessing off to choose this option.  This is useful to
merge two or more separate fractal images/types with the initial image(s) "bleeding" through.

5.7 Hide dialogs command

   Hide dialogs command (Image menu)

Use this command to hide all open non-modal dialogs in the active window.  This helps to de-clutter
the screen and avoid confusion if two or more draw windows are open.  Each draw window has its
own dialogs.  Disabled if no dialogs are open.

5.8 Show dialogs command

   Show dialogs command (Image menu)

Use this command to show all open non-modal dialogs in the active window.  This command
restores any dialogs that may have been hidden by the Hide dialogs command.  Each draw window
has its own dialogs.  Disabled if no dialogs are open or hidden.  Note: you can restore individual
dialogs by selecting the command that opened them originally.

5.9 Abort command

   Abort command (Image menu)

Use this command to stop drawing.  Clicking inside a window's drawing area or close box (or the
program close box) will also stop the drawing.  Note: once a plot has started Montezuma continues
to draw the image for that window regardless of which drawing window has the input focus, until
done or aborted.  You can open and close other drawing windows without affecting the current
drawing, but only one drawing is active at any time. 

5.10 Continue Draw

    Continue Draw (Image menu)

Continues a plot that was aborted early.  The plot is restarted at the beginning of the last row drawn.
 Continue is disabled when an Image/Merge option is selected.  Continue isn't available for 3-D
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images that have been reloaded from a previous drawing session.

5.11 Zoom command

   Zoom (Image menu)

Turns on zoom mode, so that detail of the current plot may be magnified.  Alternatively, just click
inside any drawing window, move the mouse, and the zoom box will appear.  Using the mouse,
move the zoom box over the portion of the plot you wish to magnify.  Hold the left mouse button to
shrink the box or the right button to enlarge it.  Use the up and down arrow keys to squash or
expand the box, changing the aspect of the image.  Use the Shift key to enlarge the zoom box X4 for
quickly zooming outward.  Use the Ctrl key to shrink the zoom box by 4.  You start a zoom by
pressing the space bar.  You abort a zoom by clicking outside the main window or in the title bar, or
by pressing the escape key. The program will begin a new plot at the new coordinates.  You may
zoom in by defining a box inside the current drawing area.  You zoom out by drawing a box outside
the current drawing area.  The outer zoom limits are between -1000 and 1000.  The precision is that
of double point (64 bits).

Note: As you zoom inward it will probably be necessary to increase the Steps variable (Initial 3-D
Generator Values window) to see the finer detail and avoid a jagged look.

5.12 New View on Zoom command

    New view on zoom (Image menu)

With this option enabled, a new window is opened with each zoom, instead of the zoom box area
replacing the original image.  Ignored in avi mode.

5.13 Clone command

    Clone (Image menu)

A new draw window is opened that contains the same fractal data as the window it was opened
from.  This is useful for comparing minor changes in texturing options, etc.  Similar to using the copy/
paste data commands except that all figures are copied to the new view.

5.14 Color Cycle command

   Cycle Colors command (Image menu)

Use this command to cycle colors when not plotting.  Works with only palette-based coloring, and
not with anti-aliasing.  Undoing an action disables the cycle command until the image is redrawn.

5.15 Pilot command

    Pilot (Image menu)
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Opens the Pilot window to adjust key parameters, rotate, zoom and redraw the figure interactively. 
The current image is reduced to one quarter normal for faster redraw.  Each click on a Pilot button
increments or decrements a parameter.  The Speed slider controls the rate at which the buttons
operate (default is 10.)

Press the space bar or Click on Ok to open a new window and draw the altered image full-size. 
Press Esc or click on Cancel to exit this mode without opening a new window.  Note: when using
this option while an AVI stream is open, a new window isn't opened, but the altered figure is drawn
in the current draw window, the changed parameters replacing the previous ones.

5.16 Scan command

    Scan (Image menu)

This is equivalent to the Shift+G hot key.  Enabled when the Type is Mandelbrot.  A 3-D Julia set is
generated in sector 2.  Once you find an interesting 3-D Julia set using "G", like the J command
another window is opened that sets the fractal parameters to those in the exploratory qjulia window.
The parameters in the exploratory window revert to their original Mandelbrot settings.

5.17 Ray Trace command

    Ray Trace (Image menu)

Uses Frode Gill's ray-tracer algorithm to add a light source to 3-D plots.  Color palettes should be
continuous (dark to light to dark) to take best advantage of this option.  The light source parameters
may be altered in the Ray-Tracing Variables window.  This option is the default.  Note: if you prefer
to generate quaternions without ray tracing, deselect this flag before drawing the plot.  The image
draw will be the pre-image, using the existing palette, as is, without ray-tracing (Phong or shading.) 

5.18 Full Screen command

    Full Screen (Image menu)

Displays the entire plot, expanding or shrinking the image to fit in a maximized window without title
bar, scroll bars or menu bar.  At all other times, part of the picture is hidden by the inclusion of the

title bar, toolbar, scroll bars and menu bar.  To exit full-screen mode, press any key or click the left-
mouse button.

5.19 Reset ->

    Reset (Image menu)

Reset the current figure or all figures to a 7th degree Mandelbulb.
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The Ranges Only command resets only the real Z and imaginary Z ranges in the Parameters window
(to +/-2.0 and +/-1.5 or the current draw window aspect.)  No other menus or variables are
affected.  

 The Reset All option resets all figures. 

5.20 Figure

5.20.1 1

    Figure #1 (Image menu)

Switch to Function #1.  Current settings are saved for the previous image. 

5.20.2 2

    Figure #2 (Image menu)

Switch to Function #2.  Current settings are saved for the previous image. 

5.20.3 3

    Figure #3 (Image menu)

Switch to Function #3.  Current settings are saved for the previous image. 

5.20.4 4

    Figure #4 (Image menu)

Switch to Function #4.  Current settings are saved for the previous image. 

5.20.5 Composite command

   Composite command (Image menu)

Opens the Composite Figure window, where you can define a set of figures to merge into one
image.  All the merging options in the Merge Color menu are supported, plus "ALL" which is usually
used for the first figure to be drawn.  The "ALL" option transfers all rgb information for a figure to
the drawing area, without checking the rgb state of the pixel.  You can define up to four figures
(layers), as part of the composite, but each figure should contain an image (if used in the composite.)

6 Type Menu

 Type menu commands

The Type menu offers the following commands:

Mandelbrot Mandelbrot set (orbit starts at zero.)
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Julia     Julia set.

6.1 Mandelbrot

    Mandelbrot (Type menu)

Mandelbrots base their mapping on varying inputs of complex C, which corresponds to the min/max
values set in the Parameters window.  With Mandelbrot, the initial value of Z is set to zero.

6.2 Julia

    Julia (Type menu)

Julia sets normally have a fixed complex C, with varying inputs of Z, which corresponds to the min/
max values set in the Parameters window.  This option generates the so-called 'filled-in' Julia set,
which includes non-escaping points as well as the Julia set.

7 Render Menu

  Render menu commands

The Render menu offers the following commands:

Coloring Filter Define coloring filter.
Surface Filter Define surface filter.
X Mapping Filter  Use bitmap file for 3-D rendering: X mapping.
Y Mapping  Use bitmap file for 3-D rendering: Y mapping.
Z Mapping  Use bitmap file for 3-D rendering: Z mapping.
Remap  Remap bitmap for 3-D rendering.
Link Coloring To Pixel  Set coloring to match absolute coordinates of image.
Atan Coloring Use Atan algorithm for coloring.
Bof60 Coloring  Use Bof60 algorithm for coloring.
Depth Coloring  Color by smallest depth squared.
Level Coloring  Color by level index.
Height Coloring  Color by magnitude of z.
Filter  Choose an optional tail-end filter.
Orbit Traps  Set orbit trapping method.
Add Noise  Add noise to coloring.
Factors  Edit noise factors.
Reset Noise Seed  Re-seed random noise generator.
Texture Scale  Set scaling factor for texture.
Generalized Coloring->

Apply Apply non-palette based coloring method.
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Blend->
linear scale linear scale color blending.
average  average color blending.
subtractive  subtractive color blending.
sum of squares 1 sum #1 color blending.
sum of squares 2 sum #2 color blending.
sin #1  sin color blending.
atan #1  atan #1 color blending.
additive  additive color blending.
log  log color blending.
atan #2  atan #2 color blending.
atan #3  atan #3 color blending.
sin #2  sin #2 color blending.
sin #3  sin #3 color blending.
atan #4  atan #4 color blending.
fractal dimension fractal dimension color blending.

Color Parameters  Color controls.
RGB  RGB color mapping.
RBG  RBG color mapping.
GRB  GRB color mapping.
GBR  GBR color mapping.
BRG  BRG color mapping.
BGR  BGR color mapping.
Triangle Algorithm  Handle color overflow by triangle algorithm.
Sine Algorithm  Handle color overflow by sine algorithm.
Gray Scale  Gray scale mapping.
Invert  Invert colors.
Fractal Dimension  Apply fractal dimension algorithm to current blend option.

Rendering Library Functions (rll)->
Apply Apply external rendering function....
Process Bailout Process bailout from external rendering function.
Rendering Libraries Off Disable external rendering libraries.
Color Planes   Select color planes for external rendering library.

7.1 Coloring Filter command

    Coloring Filter

Here you define a coloring filter based on a real function.  A generalization of Earl Hinrichs' sine-
wave coloring method, the function can be any formula, up to 80 characters, that uses the z-buffer
variable and framing variables x and y.  Sample function:  .1*sin(z)+cos(x*x).  The Magnify slider is
used to control the intensity of the filter.  Click on Apply to apply a new coloring formula without
closing the window.  Click on Okay to close the window and apply changes.  Click on Cancel to
close the window without applying changes.  Use the Random Filter button to generate a random
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coloring filter.  The best filters will use the z value and one of the other variables (x or y.) 

quaternions normally use palette index one (the second index, zero being reserved for the
background color) for their predominant color, with pixel intensities/colors affected by the lighting
variables.  When the coloring filter formula is defined, up to 255 colors can be used (the full palette)
to create mixed textures.
 
The trig and exponential functions translated include sine (sin), arc sine (asn), cosine (cos), arc
cosine(acs), tangent (tan), hyperbolic tangent (th), hyperbolic sine (sh), hyperbolic cosine (ch), log
(log), natural log (ln), power (pow), arc tangent (atn), absolute value (abs), exponential (exp) and
square root (sqr.)  

The math functions are *(multiply),-(subtract),/(divide), and +(add).

The constants are PI and E (ln (1)), plus any floating-point number up to 9 digits (including the
decimal point).

The power function (x to the y power) is entered in standard notation: x^y', with optional parenthesis
necessary around complex exponents or variables.

Note:  Range limits exist for arguments to these functions: exp, arc sine, hyperbolic sine, arc cosine,
hyperbolic cosine, arc tangent, and hyperbolic tangent (+/-100.0 for the exponential, +/-200.0 for
hyperbolic functions, +/-1.0 for the arc functions), the log functions (must be >0) and the power
function (x must be integral and non-zero when y<0, and 0^0 is undefined).  Square root is
undefined for x<0.  No filtering is done when these limits are exceeded.

   Syntax for an acceptable formula is AS([XY])+bs([xy])...
.up to 80 characters per formula.  Algebraic notation is supported to a limited degree.  E.G. you can
enter a variable as 2x^2, instead of 2*x*x. 
   A and B are optional constants.

S is an optional trig function (1 to three letters: 1 will work for sine, cosine and tangent, but use the
above abbreviations for the other functions.  X and Y are the standard variables.  The '+' could be
any of the math functions.

The parser interprets up to 10 levels of parenthesis.  Use parenthesis to separate complex
expressions.  Use parenthesis to embed trig functions within other trig functions, etc.

7.2 Surface Filter command

    Surface Filter

Here you define a surface filter based on a real function.  This is like a coloring filter, except that the
formula is used to warp the 3-D fractal's shape. The Magnify variable is used to control the intensity
of the filter.  Click on Apply to apply a new surface filter without closing the window.  Click on
Okay to close the window and apply changes.  Click on Cancel to close the window without
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applying changes.  Use the Random Filter button to generate a random surface filter.  The best
surface filters will use the z value and one or both of the other variables (x or y.) 

7.3 Pic-Trap Coloring

7.3.1 X mapping option

    X mapping

This option allows you to use a separate bitmap or picture to color a 3-D image.  Enabled when a
bitmap has been copied to the clipboard, each pixel of the image is replaced with a corresponding
color in the clipboard image, depending on the mapping option used (x, y or z mapping.)  This
produces textured effects that add realism to the image.  Notes: the internal structure of the 3-D
image is used to determine each mapping algorithm, so the overall effect is to texture the image like a
wood-grain rather than a decal.  When you first enable this option, whatever is in the clipboard gets
copied to a buffer file for rendering.  To change the picture in the buffer, you need to change the
clipboard image then use Remap to reinitialize the buffer.  The clipboard image isn't saved with the
data file, so you need to remember which bitmap file is used for the mapping, to redo a fractal like
this later (you can sometimes leave a comment in the Fun#2 edit box in the Edit/Formula window for
this purpose.).

7.3.2 Y mapping option

    Y mapping

This option allows you to use a separate bitmap or picture to color a 3-D image.  Enabled when a
bitmap has been copied to the clipboard, each pixel of the image is replaced with a corresponding
color in the clipboard image, depending on the mapping option used (x, y or z mapping.)  This
produces textured effects that add realism to the image.  Notes: the internal structure of the 3-D
image is used to determine each mapping algorithm, so the overall effect is to texture the image like a
wood-grain rather than a decal.  When you first enable this option, whatever is in the clipboard gets
copied to a buffer file for rendering.  To change the picture in the buffer, you need to change the
clipboard image then use Remap to reinitialize the buffer.  The clipboard image isn't saved with the
data file, so you need to remember which bitmap file is used for the mapping, to redo a fractal like
this later (you can sometimes leave a comment in the Fun#2 edit box in the Edit/Formula window for
this purpose.).

7.3.3 Z mapping option

    Z mapping

This option allows you to use a separate bitmap or picture to color a 3-D image.  Enabled when a
bitmap has been copied to the clipboard, each pixel of the image is replaced with a corresponding
color in the clipboard image, depending on the mapping option used (x, y or z mapping.)  This
produces textured effects that add realism to the image.  Notes: the internal structure of the 3-D
image is used to determine each mapping algorithm, so the overall effect is to texture the image like a
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wood-grain rather than a decal.  When you first enable this option, whatever is in the clipboard gets
copied to a buffer file for rendering.  To change the picture in the buffer, you need to change the
clipboard image then use Remap to reinitialize the buffer.  The clipboard image isn't saved with the
data file, so you need to remember which bitmap file is used for the mapping, to redo a fractal like
this later (you can sometimes leave a comment in the Fun#2 edit box in the Edit/Formula window for
this purpose.).

7.3.4 Remap command

    Remap

This allows you to change the mapping buffer, after initializing an image with X, Y or Z mapping. To
change the picture in the buffer, you need to change the clipboard image then use Remap to
reinitialize the buffer.

7.4 Link Coloring To Pixel command

    Link Coloring To Pixel (Render menu)

Set coloring to match absolute coordinates of image.  This uses extra buffers to track a figure's
texture, so that when you rotate it, the texture moves with the figure.  Used with the Atan Coloring,
Bof60 Coloring, Height Coloring, Filter, Orbit Traps and the Noise functions.  

7.5 Atan Coloring command

    Atan Coloring (Render menu)

Uses an Atan algorithm by David Makin to color an image. 

7.6 Bof60 Coloring command

    Bof60 Coloring (Render menu)

A variation of the Bof60 algorithm found in the classic Pietgen/Ricter text, The Beauty of Fractals,
adapted by David Makin to color a 3-D image. 

7.7 Depth Coloring

   
    Depth Coloring (Render Menu)

Another variation of the Bof60 coloring method, where color is determined by the square of the smallest
depth a point on the 3-D surface reaches during iteration.

7.8 Level Coloring

    Level Coloring (Render Menu)
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Coloring is based on how many times a point's escape value is reduced during iteration.

7.9 Height Coloring command

   Height Coloring (Render menu)

The magnitude of z (at the 3-D border) is used to color the image. 

7.10 Filter command

    Filter (Render menu)

Based on Stephen C. Ferguson's filter algorithms in his program Iterations, this option allows you to
choose one of 26 tail-end filters for surface rendering.  Corresponds roughly to its effect on the basic
Mandelbrot-squared set.  The effect will vary with the formula and fractal type chosen.  

The Magnify variable is used to intensify or de-intensify the effect of the filter.  This value can range
from 1-500 nominally. Click on Apply to apply a new filter without closing the window.  Click on
Okay to close the window and apply changes.  Click on Cancel to close the window without
applying changes.  

7.11 Orbit Trap Coloring

    Orbit Trap Coloring

This includes methods that trap the orbit of a point if it comes in range of a pre-specified area or
areas. 
 
Enter a value for Epsilon and Epsilon2, which are used to define the size of the orbit trap areas
(.001-2.0 and 0.0-epsilon.)  The exclude box is used to exclude the first # iterations (0-99) from
orbit trapping. 

Click on Apply to apply changes without closing the window.  Click on Okay to close the window
and apply changes, if any.  Click on Cancel to exit the window without changing parameters.

Epsilon2 is used to create windows into the stalks.  The default value is 0.0, which produces solid
stalks.  Epsilon2 has no effect on the Petal method.

7.12 Noise

7.12.1 Add Noise command

    Add Noise (Render menu)

Add noise to image texture.  A variation of Perlin's noise algorithm is used to add natural
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randomness to an image's coloring.  

7.12.2 Factors command

    Factors (Render menu)

Edit noise factors.  The Blend variable determines how much noise is added to an image.  The higher
the blend, the more pronounced the noise appears.  This also tends to darken an image, which can
be compensated for by decreasing Gamma.  The Grain variable determines the frequency of the
noise.  The higher the grain, the noisier the image appears.  You can adjust how the noise maps to an
image by changing the scale factors.  Higher scale factors make the image noisier on the respective
axis (x, y and z.)  Additional variables affect the type and shaping of the noise data: Gaussian is an
alternate form of noise, while Planet, Check, Tooth, Barber and Wood apply a specific envelope to
the noise.  The Marble variable is used to introduce a low frequency or high frequency modulation
on top of the noise.  You can achieve marble-like textures by combining a high frequency marble
value with a low frequency Blend value.  The marble variable also adds a high-frequency bump map
to the wood envelope.

The Surface Warp variable allows you to apply the same noise to a (3-D) figure's shape also, like a
surface filter.  Small values are best for creating realistic surface variations, like stone and wood
grain. 

7.12.3 Reset Noise Seed

    Reset Noise Seed (Render menu)

The random noise generator is re-seeded.  Use this to create variations on the noise texture. 

7.13 Texture Scale command

    Texture Scale (Render menu)

Opens a window to edit texture scale factors.  The higher the scale factors, the more repetitive the
texture becomes.  You can adjust the factors to make the texture asymmetrical on the x, y or z-axis.
Scale A is used to adjust the texture scale for the Depth, Level, Height, Filter and Bof60 coloring
options, or when neither of these options is selected.  (Scale X, ScaleY, and Scale Z are used with
the Coloring filter, Orbit Trap and Generalized Coloring methods.) Click on Apply to apply changes
without closing the window.  Click on Okay to close the window and apply changes.  Click on
Cancel to close the window without applying changes. 

7.14 Generalized Coloring

7.14.1 Apply command

   Apply command (Render menu)

Use this command to switch to Steve Ferguson's generalized coloring mode.  Images are colored via
the selection in the Blend submenu and color-controls dialog, instead of the palette-based coloring
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filters.  To switch back to palette mode, apply a coloring filter or one of the palette-based textures,
such as Atan, Potential or one of the orbit traps.

7.14.2 Blend

7.14.2.1 linear scale command

   linear scale command (Blend submenu)
This is color blending for the generalized coloring mode.  The selected formula is applied while
mapping colors to pixels.

7.14.2.2 average command

   average command (Blend submenu)
This is color blending for the generalized coloring mode.  The selected formula is applied while
mapping colors to pixels.

7.14.2.3 subtractive command

   subtractive command (Blend submenu)
This is color blending for the generalized coloring mode.  The selected formula is applied while
mapping colors to pixels.

7.14.2.4 sum of squares 1 command

   sum of squares 1 command (Blend submenu)
This is color blending for the generalized coloring mode.  The selected formula is applied while
mapping colors to pixels.

7.14.2.5 sum of squares 2 command

   sum of squares 2 command (Blend submenu)
This is color blending for the generalized coloring mode.  The selected formula is applied while
mapping colors to pixels.

7.14.2.6 sin #1 command

   sin #1 command (Blend submenu)
This is color blending for the generalized coloring mode.  The selected formula is applied while
mapping colors to pixels.

7.14.2.7 atan #1 command

   atan #1 command (Blend submenu)
This is color blending for the generalized coloring mode.  The selected formula is applied while
mapping colors to pixels.

7.14.2.8 additive command

   additive command (Blend submenu)
This is color blending for the generalized coloring mode.  The selected formula is applied while
mapping colors to pixels.
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7.14.2.9 log command

   log command (Blend submenu)
This is color blending for the generalized coloring mode.  The selected formula is applied while
mapping colors to pixels.

7.14.2.10 atan #2 command

   atan #2 (Blend submenu)
This is color blending for the generalized coloring mode.  The selected formula is applied while
mapping colors to pixels.

7.14.2.11 atan #3 command

   atan #3 (Blend submenu)
This is color blending for the generalized coloring mode.  The selected formula is applied while
mapping colors to pixels.

7.14.2.12 sin #2 command

   sin #2 command (Blend submenu)
This is color blending for the generalized coloring mode.  The selected formula is applied while
mapping colors to pixels.

7.14.2.13 sin #3 command

   sin #3 command (Blend submenu)
This is color blending for the generalized coloring mode.  selected formula is applied while mapping
colors to pixels.

7.14.2.14 atan #4 command

   atan #4 command (Blend submenu)
This is color blending for the generalized coloring mode.  The selected formula is applied while
mapping colors to pixels.

7.14.2.15 fractal dimension command

   fractal dimension command (Blend submenu)
This is color blending for the generalized coloring mode.  The selected formula is applied while
mapping colors to pixels.  Uses an early version of Steve Ferguson's fractal dimension algorithm.

7.14.3 Color Parameters command

   Color Parameters command (Render menu)

Use this command to adjust the color controls when in the generalized coloring mode.
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7.14.4 RGB command

   RGB command (Render menu)

Use this command to use red/green/blue mapping, if in the generalized coloring mode.

7.14.5 RBG command

   RBG command (Render menu)

Use this command to use red/blue/green mapping, if in the generalized coloring mode. 

7.14.6 GRB command

   GRB command (Render menu)

Use this command to use green/red/blue mapping, if in the generalized coloring mode.

7.14.7 GBR command

   GBR command (Render menu)

Use this command to use green/blue/red mapping, if in the generalized coloring mode. 

7.14.8 BRG command

   BRG command (Render menu)

Use this command to use blue/red/green mapping, if in the generalized coloring mode.

7.14.9 BGR command

   BGR command (Render menu)

Use this command to use blue/green/red mapping, if in the generalized coloring mode. 

7.14.10 Sine algorithm command

   Sine Algorithm command (Render menu)

When color values exceed the range of rgb components, the values are scaled with Steven C.
Ferguson's sine algorithm (non-palette mode only.)

7.14.11 Sawtooth algorithm command

   Triangle Algorithm command (Render menu)

When color values exceed the range of rgb components or palette indexes, the values are scaled
with a triangle algorithm, or linear ramp (non-palette mode only.)
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7.14.12 Gray Scale command

   Gray Scale command (Render menu)

Use this command to color the active image with gray tones, if in the generalized coloring mode.  

7.14.13 Invert command

   Invert command (Render menu)

Use this command to invert image colors, if in the generalized coloring mode.  

7.14.14 Fractal Dimension command

   Fractal Dimension command (Render menu)

Generalized fractal dimension algorithm (S. Ferguson), for use with any blend option (Blend 14 is
retained for compatibility with the previous QSZ version.)  

7.15 Rendering Library Functions (rll)

7.15.1 Apply command

   Apply (external rendering function) command (Render menu)

Use one of the TieraZon2-compatible-plug-in rendering methods.  To use, this option automatically
enables generalized coloring mode.  There is a large potpourri of rendering methods (280+) in the
TieraZon/Dofo-Zon Elite and Mark Townsend/Kerry Mitchell libraries that you can experiment
with.  Some have their own bailout routines that can distort the basic 3-D shape in interesting ways. 
For version 1.03 plugins, each method can have its own dedicated configuration box, containing as
many variables as is needed to customize the function.  Pre-1.03 plugins use a fixed configuration
box, with only a scaling and orbit-trap variable.  Note: selecting one of the palette-based rendering
methods in the Render menu, such as Atan or Potential Coloring, or selecting a 2-D fractal Type,
will disable and deallocate any external rendering function in use.  

7.15.2 Process Bailout command

   Process Bailout command (Render menu)

Deselect this option if you don't want to use an external rendering function's bailout routine.  The
bailout routine can sometimes distort a 3-D shape in undesirable ways, or you may like the coloring
effect of the rendering method by itself.

7.15.3 Rendering  libraries off command

   Rendering Libraries off command (Render menu)

Disable and deallocate the external rendering function selected.
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7.15.4 Color Planes command

   Color Planes (Render menu)

Since most of the external coloring algorithms were originally written for 2-D fractals, there is the
choice which two planes are used for coloring purposes.  In the case of 3-D fractals, the X and Y
planes don't always match the coloring algorithm to the fractal.  With these options you can select
which two planes the coloring algorithm uses or select the magnitude of all four planes.

8 Pixel Menu

  Pixel menu commands

The Pixel menu offers the following commands:

Phoenix Phoenix orientation.
Invert  Invert image around circle.
Invert Off  Reset inversion flag.
Switch Z For C  Switch z for c.
Solid-Guessing  Solid-guessing plotting mode.
Distance Estimator Map 3-D fractal using distance estimator method

Mirror Mode Flip image after drawing

8.1 Phoenix option

    Phoenix option (Pixel menu)

The Phoenix flag rotates the planes, so that the imaginary plane is mapped horizontally and the real
plane is mapped vertically.

8.2 Invert command

    Invert (Pixel menu)

The Invert flag inverts the plane around a circle. A window is opened that allows the user to specify
the circle's radius and center coordinates.  Select Auto Coords to let Montezuma calculate the
center coordinates and circle radius.  Using Auto Coords, the new radius and center coordinates are
calculated when the picture is next drawn.  You can zoom on an inverted picture as long as radius
and center coordinates remain the same.  Use the Perspective box to alter the X/Y symmetry of the
inversion.  A smaller Perspective value (less than 1.0) stretches the inversion in the vertical direction.
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8.3 Invert Off  command

    Invert Off (Pixel menu)

Turns off the inversion flag.  Alternatively you can set the inversion radius to 0.0 to turn off inversion.

8.4 Switch command

    Switch Z For C

When a Switch flag is set, you have switch Z for C.  When Z is switched for C, normally you get
Mandelbrots from Julia sets and vice versa. 

8.5 Solid Guessing

    Solid Guessing (Pixel menu)

In the solid-guessing plotting mode, the program guesses at colors that lie inside rectangular areas of
the plot.  It first computes all the perimeter pixels of a rectangle, and checks if all the pixels have the
same color as the background (palette index 0).  If so, all the pixels inside the rectangle are colored
the same and no further calculations are done on that rectangle.  Otherwise the rectangle is broken
into four parts and the above procedure is repeated for each part.  If any of the perimeter pixels are
different at this point, all the remaining pixels in the smaller rectangle are computed.  The screen is
updated in groups of 16 lines.  Solid-guessing is disabled when the drawing aspect (width/height) is
not 4/3 or 1/1.

8.6 Distance Estimator

  Distance Estimator

With this option selected, the distance estimator algorithm is used to map the 3-D surface (instead of
fixed steps.)  Distance estimating speeds up the image processing and is more accurate than using
fixed steps to locate the 3-D surface.  Accuracy becomes critical the closer to the 3-D surface you
zoom in on.  With this option de-selected, fixed steps are used to map the 3-D surface, which results
in much slower processing for the same resolution (and a less accurate image.)  Fixed steps are
useful to visualize and export 3-D objects, since the export routine works at much lower resolution
(due to memory constraints) than achievable with the distance estimator method.

8.7 Mirror Mode

Mirror Mode

This option flips the drawing from left to right, which corresponds to how objects are exported.  This gives
you a a more accurate picture of how objects will appear in ray-tracing programs like Bryce.
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9 View Menu

  View menu commands

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar      Shows or hides the status bar. 

9.1 Toolbar command

  Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the most
common commands in Montezuma, such as File Open.  A check mark appears next to the menu
item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.

9.1.1 toolbar

  Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.  The toolbar
provides quick mouse access to many tools used in Montezuma,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Open the QSZ Remote which contains shortcut buttons for many common tasks and
options in Montezuma

Use Pilot to rotate figure, zoom and alter key cubic variables.

Open a new drawing, based on the default template.

Open an existing drawing.  Montezuma displays the Open dialog box, in which you can
locate and open the desired file.

Save the active drawing or template with a new name.  Montezuma displays the Save
As dialog box.

Set image size.

Edit formula/type data.

Edit fractal parameters.

Edit ray-tracing variables.

Edit palette.
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Draw image from current parameters.

Continue drawing.

Zoom into rectangle.

Show picture full-screen.

Reset coordinates.

Draw Mandelbrot set

Draw Julia set

Display info about Montezuma.

Display Montezuma's help index.

9.2 Status Bar Command

 Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be executed by
the selected menu item or depressed toolbar button, and keyboard latch state. A check mark
appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.

9.2.1 status bar

 Status Bar

The status bar is displayed at the bottom of the Montezuma window.  To display or hide the status
bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate
through menus.  This area similarly shows messages that describe the actions of toolbar buttons as
you depress them, before releasing them.  If after viewing the description of the toolbar button
command you wish not to execute the command, then release the mouse button while the pointer is
off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.

10 Window Menu

  Window menu commands
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The Window menu offers the following commands, which enable you to arrange multiple images in
the application window:

Cascade   Arranges windows in an overlapped fashion.
Tile     Arranges windows in non-overlapped tiles.
Arrange Icons     Arranges icons of closed windows.
Size Desktop     Size drawing area to window frame.
Window 1, 2, ... Goes to specified window.

10.1 Cascade command

Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 

10.2 Tile command

Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.

10.3 Arrange Icons command

Window Arrange Icons Command

Use this command to arrange the icons for minimized windows at the bottom of the main window.  If
there is an open drawing window at the bottom of the main window, then some or all of the icons
may not be visible because they will be underneath this drawing window. 

10.4 Size Desktop command

Window Size DeskTop Command

Use this command to size the active drawing window to its frame size.  Use after Tile command to
reduce white space around a drawing that is smaller than screen size.

10.5 1, 2, ... command

1, 2, ... command (Window menu)

Montezuma displays a list of currently open drawing windows at the bottom of the Window menu. 
A check mark appears in front of the drawing name of the active window.  Choose a drawing from
this list to make its window active.  
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11 Demo Menu

  Demo menu commands

The Demo menu offers the following commands, which illustrate various features of Montezuma:

Random JuliaSet Generate Julia Set fractal.
Random Render Apply random coloring filter or generalized coloring.
Batch Mode/Random Setup Set up initial values for batch mode/random commands.

11.1 Random Julia Set command

    Random Julia Set (Demo menu)

A random Julia Set fractal is generated using the current fractal type.  

11.2 Random Render command

    Random Render (Demo menu)

A random coloring filter or generalized coloring is applied.  This changes the surface textures of the
3-D figure.

11.3 Batch Mode/Random Setup

    Batch mode/Random Setup (Demo menu)

Here you set parameters for batching and saving random-generated images to disk.  You can also
customize random variables to direct how the random scanning process works.  When the
Repetitions value is non-zero, up to 1000 random images can be generated and saved to disk.  Use
a unique Filename to prevent batch files from overwriting existing image files.  You can also change
the default directory for batch files, by clicking on the "…" button next to the default directory box. 
The Scan Limit directs the program on how many scans it makes through each formula before it
skips to a new formula (if an interesting 3-D fractal hasn't been found.)

If you select this option before opening a video stream, then instead of an AVI stream, the program
initializes a set of bmp image files.  Each 'frame' is written to the directory specified in the Demo/
Batch mode window.  Each frame is numbered with a postfix to the Batch-mode name from 0000 to
9999, e.g. 'quat0001.bmp'.

There are radio boxes that allow you to customize how random variables are processed to create
new 3-D fractals:

Formula  -- (default on) check to randomize built-in formula used
Lighting  -- (default off) check to set default lighting
Rotation -- (default on) check to randomize camera angles
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Coloring -- (default off) check to reset coloring parameters
Max. Iterations -- (default off) check to randomize maximum iterations
Z-Space -- (default on) check to set default z-space
Constants  -- (default on) check to randomize the complex constant cj

The Bounds variable (default 0) acts to delimit the boundary scan after finding a random Julia set. 
Since the scanning process is closely connected with the Mandelbrot set boundaries, most 3-D
fractals found this way are very connected/closed figures.  The bounds variable adds a random
distance from the Mandelbrot boundary to produce more open fractals.  A good value to start with
is 20 if you want to experiment with this option.

12 Video Menu

  Video menu commands

The Audio/Video menu offers the following commands:

Write Avi Video Write video buffer to file.
Add Key Frame Add image to video buffer.
Reset Frames  Reset frame buffer.
Edit Frames  Edit frames in frame buffer.
Load Frames [MNV] Load frame buffer.
Save Frames [MNV] Save frame buffer.

View AVI  View an AVI animation file.
AVI Composite  Generate composite video.

12.1 Write Avi Video

    Write Avi Video

Through a series of windows, this allows you to name and open an avi animation stream and choose
a compression method.  After using the file requester to name the file, you are given a choice of
compression methods.  The compression methods include Intel Indeo Video®, Microsoft Video 1
and Cinepak Codec by Radius.  (All compression methods degrade the original images, some more
than others.)  The frames defined by the frame buffer are then plotted and written to the avi stream
and the stream closed.  Variables between each key frame are interpolated and frames added to the
avi file to give the illusion of animation. 

12.2 Add Key Frame

  Add Key Frame

Montezuma uses a frame buffer to compose an animation.  You add key frames to the buffer with
this command.  Each key frame is identical to the active image.  Change  variables between key
frames to create the illusion of motion or morphing.  You can edit the frames with the frame editor.
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12.3 Reset Frames

   Reset Frames

Delete the current frame buffer.  The number of video frames is reset to zero.

12.4 Edit Frames

    Edit Frames

When the frame editor window is open you can edit the frames in the video buffer by using any of
the other editor windows.  The Move button allows you to move a frame from one spot in the buffer
to another.  You can change the frame image being edited by using the Frame slider or Edit box. 
After changing frames, use the Preview button to display the current frame being edited.  The Delete
button allows you to delete all but two of the frames, the minimum number of frames to create a
movie.  (If you want to delete all the frames, use the Video/Reset Frames command.) The Spread
variable determines how many frames are generated between key frames.  A higher value produces
a smoother video, but also adds to the file size.

12.5 Save Frames [MNV]

This command saves the current frame buffer in a [mnv] file.  A file requester is opened that allows
you to choose the location and name of the frame library.  The frame buffer files can also be used as
image libraries, similar to Fractint's par and frm formats.  The frames contain all the information to
reproduce an image at any supported size.

12.6 Load Frames [MNV]

Load a frame buffer that has been previously saved by Montezuma.  The buffer replaces any existing
frame buffer.

12.7 View Avi

    View Avi…

Opens an avi file for viewing.  You can preview any multimedia file by clicking on its file name.  A
multimedia box will appear to the right of the file list.  Click on okay to open the main view window.

There are buttons to Play a file forwards or Backwards, or forward automatically with Auto rewind/
repeat.  Click on Slow to slow down a video.  Each click on Slow halves the viewing speed.  A
click on Stop freezes viewing and restores the view speed to normal playback.

Use the Open button to view a different avi file.  Use the Save button to save the file in a different
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compression format.  You must use a different name to save the file than the name that was used to
open it.  Click on the left-mouse button or any key to abort a save operation.

Note: the view avi requester can be used to preview any multimedia file, including midi files.

12.8 Avi Composite option

    AVI Composite (Video menu)

When this flag is set, Montezuma generates composite frames for a video according to the settings in
the Image/Composite window.  Each frame may then consist of a merging of up to 4 figures (1-4). 
You must set this flag and the composite options before beginning a video.

13 Help Menu

  Help Menu

The Help menu offers the following commands, which provide you assistance with this application: 
Index      Offers you an index to topics on which you can get help.
About Montezuma      Displays the version number and author info for this application.

Additional Topics:
Getting Started     Tutorial for new users of Montezuma.
Hot Keys      Quick reference to Montezuma's hot keys.
Built-in Formulas     Quick reference to Montezuma's built-in formulas.
Bibliography      Sources for fractal information and complex numbers.

13.1 Index command

Index command (Help menu)

Use this command to display the opening screen of Help.  From the opening screen, you can jump
to step-by-step instructions for using Montezuma and various types of reference information.  

Once you open Help, you can click the Contents button whenever you want to return to the opening
screen.

13.2 About Montezuma

    About Montezuma

>>>>> Montezuma™  v1.00 © 2011 by Terry W. Gintz
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Montezuma was written to take advantage of the new generation of 64-bit computers now on the
market.   Export models can be up to 10 million faces or more, unsimplified, limited only by the
amount of system memory available. Montezuma runs only on 64-bit Windows.

Montezuma graphs 3-D slices of formulas based on multi-dimensional fractal spaces.  Montezuma
currently supports quaternion, hypernion, complexified quaternion, mandelbulb and mandelbox
renderings of the Mandelbrot set and Julia sets.  A random image generator, batch mode and
integrated video routines make the program easy for beginners and a powerful complement to
advanced fractal artists.

Montezuma requires a true-color video adapter for best results.  It works in 16-bit (high color) also.

Acknowledgements: Special thanks to Elizabeth R. Chen for helping me incorporate a distance
estimator and other improvements to the 3-D generator, to Krzysztof Marczak and his team of
Mandelbulber programmers for their hybrid fractal examples,  to Tom Beddard for his ambient
occlusion and contrast examples, to Frode Gill for his fixed-step quaternion and simplified ray-
tracing algorithms, to Dirk Meyer for his Phong-shading algorithm, and to David Makin for sharing
his ideas on quaternion colorings, depth of field and distance estimators.  Thanks also to Francois
Guibert for his Perlin noise example, and to Kerry Mitchell and Mark Townsend for allowing me to
incorporate their coloring methods from Ultra Fractal.

For a short history of this program, see Chronology.

13.3 Getting Started

    Getting Started

Welcome to Montezuma!
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This is a short tutorial that will cover basic commands and background material necessary for a new
user to create an initial picture with Montezuma.  For help on any menu command, press F1 while
the command is highlighted.  For help on the Edit Formula or Parameters window, click on the Help
button inside that window.

Start by resetting all Figures, using the Image/Reset All menu option.  The drawing window is erased
and a 7th degree Mandelbulb map of the Mandelbrot set is drawn.  The 2D Mandelbrot set is
frequently considered a map of all Julia sets.  Here we are just interested in what 3D Julia sets can
be generated using the 3D Mandelbrot as a rough map.  Use the hot key combo shift-G to turn on a
3-D exploratory mode.  The cursor changes and you can click on any portion of the draw window. 
If you left-click inside the draw window, the right-hand corner (in this case called sector 2) will be
erased, and a miniature version of the 3-D Julia set that uses that space as its constants will be
drawn.  You can continue to click on areas of the draw window and see what Julia set lies there, or
you can press the space bar to open a new window and draw the 3-D fractal full-size.  Press 'Esc'
to exit this mode without creating a new window.

Once you've found and drawn a 3-D fractal that looks good, you can change its palette or surface
pattern.  Use the palette editor to create a custom palette, or even create a random palette using the
Random button.  You can change the mapping of the palette by editing the Coloring Filter, or click
on Demo/Random Render and let Montezuma pick a coloring filter at random.
If you want to see the 3-D fractal rotated at different angles, you can use the shift-R hotkey.  This
works like 'G' except that the cursor keys and Invert/Delete keys are used to rotate the image in 10-
degree increments.  See the hot key list for more information.

You'll probably be doing a lot of zooming and framing on your plots later, so we'll cover that briefly
here.  After the 3-D fractal is finished (or as much of it is finished that you want to zoom in on),
select the Zoom command off the Image menu, or just point and click the left-mouse button over any
area of the drawing.  A box a quarter the size of the window will appear that you can move around
with the mouse.  Hold the left-mouse button down to shrink the box, or the right-mouse button
down to expand the box.  Move the box over the area you are zooming in on, size the box if
necessary and when it includes the details you want, press the space bar.  The plot will be redrawn
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at zoom scale.  To zoom out, you can use the Shift key to expand the zoom box X 4.  To exit this
mode without zooming, click on the title bar of the draw window or press 'Esc'.  Most of the time
you'll be zooming in to reframe a 3-D fractal, or zooming out to include parts of the 3-D fractal that
may appear outside the default z-space.

Special note: As you explore the many options included in Montezuma you'll find that many of the
variable windows are non-modal, so they can stay open while the fractal is being plotted.  This
allows you to change some coloring and lighting variables without redrawing the fractal, or
repeatedly experiment with other aspects of the fractal-design process.  All of the non-modal
windows have an Apply button for applying changes directly without closing the window, or an
Okay button for applying changes and closing the window.  To close the window without making
any further changes, click on the window's close button.  The Cancel button, if present, allows you
to revert to when the window was last opened.  Some commands external to the window may cause
it to close and reopen if variables were changed externally.  In this case Cancel "goes back" to after
the window was reopened.  

Montezuma allows you to Undo the last command in most cases.  However this is mostly a failsafe
command, as it disables color cycling and requires you to redraw the fractal to change colors or
lighting variables.

This completes the Getting Started tutorial.  Be sure to read the hot keys and built-in formulas
sections for additional info.  The Bibliography lists additional reference material for a better
understanding of the fractal types and functions contained in Montezuma.

13.4 Hot Keys

    Hot keys

Shift-G -- A 3-D Julia set is generated in sector 2.  Once you find an interesting 3-D Julia set using
"G" (by clicking in any area around the Mandelbrot borders or anywhere in the draw window),
press the space bar and another window is opened that sets the fractal parameters to those in the
exploratory qjulia window.  The parameters in the exploratory window revert to their original
Mandelbrot settings.  Click on the escape key to exit this mode without generating a 3-D fractal set.

Shift-W -- like "G" except this modifies the cj and ck elements of the complex constant to locate a 3-
D Julia set.  

Shift-S -- a combination of the "G" and "W" commands.  The "W" command  is implemented with
the right mouse button.

Shift-F -- generate a Julia 3-D set from a formula's Mandelbrot space.  Random points in a
formula's current Mandelbrot space are scanned for an interesting Julia set.

Shift-T -- annotate a picture with text.  Cursor changes to a crosshatch, which you position over the
area where you want the text to start.  Then click the left-mouse button to transfer any text (from the
Edit/Text window) to the picture.  Can be used with Undo.  Use the Edit/Text command to change
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font, text color or format text into multiple lines.  This is useful for adding copyright/author info to a
finished picture.

up arrow --- forward cycle colors one step, including set color -- useable during plotting.
down arrow --- back cycle colors one step, including set color -- useable during plotting.

Shift-C -- clear the draw window to the current background color.

13.5 Built-in Formulas

    Built-in Formulas (enter the following prefix into the Fun #1 edit box)

    a0; z^n+c  (Note 1)
    a1; z^n+m*z-c
    a2; z^n-c
    a3; z^n+m*z+c
    a4; z^n-m*z+c
    a5; z^n+z^m+c
    a6; m*cz+cz^n-c
    a7; z^n+cz^m+c
    a8; z^n+cz^m-c
    a9; m*cz+cz^n+c

    b0; z^n+z^m-c
    b1; z^n+(m+.5)*zn*c
    b2; z^n-(m+.5)*zn*c
    b3; z^((m+.5)*zn+n)+c
    b4; z^((m+.5)*zn+n)-c
    b5; z^n+1/z^m+c
    b6; z^n-z^m+c
    b7; z^n-z^m-c
    b8; z^n+m*zn+c
    b9; z^n+m*zn-c

    c0; Mandelbox  (Note 2)
    c1; User-Defined Mandelbulb z^n+c
    c2; Hybrid

Note 1: 'n' and 'm' are entered into their respective boxes in the Edit/
Formula/Type window.
Note 2: The Mandelbox formula requires a much larger z-space than any of
the other fractal types.  When switching from another fractal type, you
need to zoom out several times initially to see the entire box.  The z-
space occupied by the box will vary with the degree of the box.

13.6 Bibliography

    Bibliography
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13.7 Chronology

   Chronology

History of this program:

In September 1989, I first had the idea for a fractal program that allowed plotting all complex
functions and formulas while attending a course on College Algebra at Lane College in Eugene,
Oregon.  In November 1989, ZPlot 1.0 was done.  This Amiga program supported up to 32 colors,
640X400 resolution, and included about 30 built-in formulas and a simple formula parser.

May 1990 -- ZPlot 1.3d -- added 3-D projections for all formulas in the form of height fields.

May 1991 -- ZPlot 2.0 -- first 236-color version of ZPlot for Windows 3.0.

May 1995 -- ZPlot 3.1 -- ZPlot for Windows 3.1 -- 60 built-in formulas.  Added hypercomplex
support for most built-in formulas.

May 1997 -- ZPlot 24.02 -- first true color version of ZPlot --  91 built-in formulas.  Included
support for 3-D quaternion plots, Fractint  par/frm files, Steve Ferguson's filters, anti-aliasing and
Paul Carlson's orbit-trap routines.

June 1997 -- ZPlot 24.03 -- added Earl Hinrichs Torus method.

July 1997 -- ZPlot 24.08 -- added HSV filtering.

December 1997 -- Fractal Elite 1.14  --  100 built-in formulas; added avi and midi support.

March 1998 --Split Fractal Elite into two programs, Dreamer and Medusa(multimedia.)

April 1998 -- Dofo 1.0 -- supports new Ferguson/Gintz plug-in spec.

June 1998 -- Dofo-Zon -- redesigned multi-window interface by Steve Ferguson, and includes
Steve's 2-D coloring methods.

August 1998 --Dofo-Zon Elite -- combination of Fractal Elite and Dofo-Zon

October 1998 -- Dofo-Zon Elite v1.07 -- added orbital fractals and IFS slide show.

November 1998 -- Dofo-Zon Elite v1.08 -- added lsystems. 

April 1999 -- Split Dofo-Zon Elite into two programs: Fractal Zplot using built-in formulas and
rendering methods, and Dofo-Zon to support only plug-in formulas and rendering methods.

May 1999 -- Fractal Zplot 1.18 --  added Phong highlights, color-formula mapping and random
fractal methods.
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June 1999 -- completed Fractal ViZion -- first version with automatic selection of variables/options
for all fractal types.

July 1999 -- Fractal Zplot 1.19 -- added cubic Mandelbrot support to quaternion option; first pc
fractal program to render true 3-D Mandelbrots.

September 2000 -- Fractal Zplot 1.22 -- added support for full-screen AVI video, and extended
quaternion design options

October 2000 -- QuaSZ(Quaternion System Z) 1.00 -- stand alone quaternion/hypernion/cubic
Mandelbrot generator

November 2000 -- Added octonion fractals to QuaSZ 1.01.

March 2001 -- Cubics 1.0 -- my first totally-3-D fractal generator.

May 2001 -- QuaSZ 1.03 -- added Perlin noise and improved texture mapping so texture tracks
with animations.

June 2001 -- Fractal Zplot 1.23 -- added Perlin noise and quat-trap method.

July 2001 -- QuaSZ 1.05 -- improved performance by converting many often-used dialogs to non-
modal type.
November 2001 -- DynaMaSZ 1.0, the world's first Dynamic Matrix Systems fractal generator

January 2002 -- MiSZle 1.1 -- generalized fractal generator with matrix algebra extensions

May 2002 -- DynaMaSZ  SE 1.04 (unreleased version)-- scientific edition of DMZ, includes
support for user-variable matrix dimensions (3X3 to 12X12)

January 2003 -- PodME 1.0 -- first stand-alone 3-D loxodromic generator, Hydra 1.0 -- first 3-D
generator with user-defined quad types and Fractal Projector a Fractal ViZion-like version of DMZ
SE limited to 3X3 matrices

May 2003 -- QuaSZ 3.052 -- added genetic-style function type and increased built-in formulas to
180.  Other additions since July 2001: generalized coloring, support for external coloring and
formula libraries, and Thomas Kroner's loxodromic functions.

May 2003 -- FraSZle and Fractal Zplot 3.052 -- added random 3D orbital fractals, new 3D export
methods, upgraded most frequently-used dialogs to non-modal type and added genetic-style
function type.  FZ now based on FraSZle except for built-in formula list and Newton support.

July 2004 – Added the features of Hydra, Cubics and PodME to QuaSZ, now renamed "Quad
Surface Zplot".  Merged FraSZle with Fractal Zplot, and Fractal Projector with DynaMaSZ SE to
form DynaMaSZ 2, including support for the original DynaMaSZ files.
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Index
- 3 -
3d: ray trace     46

- B -
blend: 00     55

blend: 01     55

blend: 02     55

blend: 03     55

blend: 04     55

blend: 05     55

blend: 06     55

blend: 07     55

blend: 08     56

blend: 10     56

blend: 11     56

blend: 12     56

blend: 13     56

blend: fractal dimension     56

button: [ ]     15

button: |||||     15

button: >     15

button: abort     12

button: batch     12

button: bmp     14

button: channel Q1     14

button: color     13

button: draw     11

button: formula     13

button: info     13

button: jpg     15

button: load     14

button: new     11

button: params     13

button: png     14

button: rand rend     14

button: rend     13

button: save     14

button: scan     13

button: size     11

button: undo     11

button: V     15

button: view     12

button:Light     13

- C -
color: blue edit box     38

color: blue slider     38

color: cancel button     38

color: copy button     37
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color: green edit box     38

color: green slider     38

color: h/r button     37

color: invert     58

color: map button     36

color: neg button     36

color: okay button     37

color: pixel     45, 56, 57, 58

color: rand button     38

color: red edit box     38

color: red slider     38

color: reset button     37

color: reverse button     36

color: spread button     37

color: srb button     37

color: srg button     37

- D -
demo: batch mode     64

demo: random quaternion     64

demo: random render     64

- E -
edit: clip     29

edit: copy     29

edit: copydata     30

edit: formula     30

edit: palette     35

edit: parameters     33

edit: paste     29

edit: pastedata     30

edit: preferences     39

edit: ray-tracing variables     34

edit: size     33

edit: text     39
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edit: undo     29

exit     28

- F -
files: load jpeg     19

files: load palette     20

files: load palettes     19

files: load parameters     19

files: load png     19

files: load texture     19

files: managing     17, 18, 28

files: save palettes     20

files: save parameters     20

files: save q polygon     21, 23, 25, 26, 27

files: save texture     20

files: set max faces     24

files: set max vertices     28

files: simplify     22

files: snooth     23

files: write jpeg     20

files: write png     20

- H -
help: about quasz     67

help: bibliography     71

help: built-in formulas     71

help: chronololgy     73

help: hot keys     70

help: remote     11

help: tutorial     5, 68
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image: auto remote     42

image: auto time     42
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image: clone     45

image: composite     47

image: continue draw     44
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image: figure     47

image: hide dialogs     44
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image: merge diff     44
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image: show dialogs     44

image: show picture     46

image:new view on zoom     45

- P -
pixel: invert     59

pixel: invert off     60

pixel: phoenix     59

pixel: solid guessing     60

- R -
render: add noise     53

render: apply     58

render: apply generalized     54

render: atan coloring     52

render: bof60 coloring     52

render: Color Plane     59

render: coloring filter     49

render: factors     54

render: filter     53

render: link coloring to pixel     52

render: orbit traps     53

render: potential coloring     53

render: Process Bailout     58

render: remap     52

render: Rendering Libraries off     58

render: reset noise seed     54

render: surface filter     50

render: switch     60

render: texture scale     54

render: x mapping     51

render: y mapping     51

render: z mapping     51
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- S -
status bar     62

- T -
toolbar     61

type: julia     48

type: mandel     48

- V -
video: avi composite     67

video: avi variables     66

video: open avi stream     65

video: view avi     66

video: write frames     66
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